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Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
ActiveMath™, ComponentWorks™, CVI ™, HiQ™, HiQ-Script™, LabVIEW™, and natinst.com™ are trademarks of 
National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.
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The Getting Results with HiQ manual contains basic information you nee
to plan projects, understand the HiQ environment, navigate efficiently 
the HiQ environment, and implement basic analysis and visualization 
features.

This manual was designed to teach you the fundamental features of H
through interactive discussions and examples. If you are new to HiQ, t
reading this manual at your computer so you can test the discussion 
concepts and examples. If you are already a HiQ user and need inform
about completing a specific task, turn directly to the section discussing 
task and complete the examples. Use the following questions and ans
to assess where you should begin in this manual.

Are you new to HiQ and need to learn the interface elements and how
to get results quickly?

Chapters 1–3 introduce HiQ, the primary interface element (the HiQ 
Notebook), and the Command Window. Try reading Chapters 2 and 3
your computer so you can explore and experiment with the Notebooks
Command Window as you learn about their features and capabilities.

Do you understand the HiQ interface and Notebook metaphor but 
need information about constructing Notebooks and enhancing them?

In Chapters 4–8, you create Notebooks from scratch and expand thos
Notebooks to include data visualization and analysis, ActiveX capabiliti
and interactive components. Each chapter contains two examples—a 
Climate Notebook and a Seismic Notebook—that build on the results of
previous chapter. At the end of Chapter 8, you will have created a comp
Problem Solver Notebook for both examples. See Conventions Used in 
HiQ Documentation for a description of the contents of each chapter. 

Do you want to share your Notebook with others?

Chapter 9, Sharing Notebooks with Others, discusses important issues 
about distributing your Notebooks with the HiQ Reader. Only the HiQ 
Professional version can create Notebooks that others can view in the
Reader.
© National Instruments Corporation xi Getting Results with HiQ
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Do you need information to complete a specific task?

Use the Contents to locate the task, and complete the examples in tha
section to learn about it.

Are you a MATLAB user looking for a way to leverage your work?

Chapter 10, Getting Results as a MATLAB User, offers suggestions that can
help you leverage the work you have already done in MATLAB. Try 
reading this chapter at your computer so you can test the suggestions
examples.

Organization of This Manual
Getting Results with HiQ is organized as follows:

• Chapter 1, Introduction to HiQ, lists system requirements and 
installation instructions, introduces the HiQ environment, and 
describes ways in which you can apply HiQ analysis and visualizat
to your projects.

• Chapter 2, Getting Results with a HiQ Notebook, introduces the 
fundamental features of the HiQ Notebook interface and shows yo
how to interact with existing Notebooks.

• Chapter 3, Getting Results with the HiQ Command Window, presents 
the Command Window. It explains how to navigate the Command
Window, get help from the Command Window, create and modify
notebooks from the Command Window, and get immediate results
using the Command Window.

• Chapter 4, Getting Your Data into HiQ, explains how you can get 
different types of data into HiQ. In this chapter, you build two 
Notebooks—the Climate Notebook and the Seismic Notebook—a
use the Import Wizard to get your data into HiQ. You enhance the
Notebooks over the next several chapters.

• Chapter 5, Visualizing Data with 2D and 3D Graphs, describes data 
visualization, which is an indispensable tool for communicating 
results, interpreting your analysis, and gaining an intuitive 
understanding of what your data represents. In this chapter, you 
enhance the Climate and Seismic Notebooks with 2D and 3D grap
displaying the data you imported in the previous chapter.

• Chapter 6, Analyzing Data with HiQ-Script, introduces HiQ-Script as 
an analysis tool. In this chapter, you analyze the data in the Clima
and Seismic Notebooks with HiQ-Script from the Command Windo
or the Notebook.
Getting Results with HiQ xii © National Instruments Corporation
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• Chapter 7, Taking Advantage of ActiveX, explains how you can use 
different ActiveX technologies in HiQ. In this chapter, you enhance
the Climate and Seismic Notebooks with ActiveX components to 
extend their capabilities.

• Chapter 8, Converting a Notebook to a Problem Solver, introduces 
problem solving Notebooks, which are useful tools for analyzing 
different data or performing different analysis on a specific data set. In 
this chapter, you complete the Climate and Seismic Notebooks by 
converting them to Problem Solvers that can analyze a variety of 
different data sets.

• Chapter 9, Sharing Notebooks with Others, describes how you can 
distribute HiQ Notebooks to effectively communicate your data 
analysis and visualization with others.

• Chapter 10, Getting Results as a MATLAB User, summarizes the 
MATLAB to HiQ transitional tools—such as the HiQ Command 
Window, the automated M-File to HiQ-Script translator, and 
HiQ-Script for MATLAB users—and describes how MATLAB users
can use these HiQ features to leverage work they have already do
in MATLAB.

• Appendix A, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.

• The Glossary contains an alphabetical list and description of terms
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols. 

• The Index contains an alphabetical list of key terms and topics in this 
manual, including the page where you can find each one.

Conventions Used in HiQ Documentation
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence Help»HiQ Help Topics directs you to pull 
down the Help menu and select the HiQ Help Topics item. This symbol 
also represents the MATLAB prompt.

This icon to the left of bold italicized text denotes a note, which alerts you
to important information.

bold Bold text denotes the names of menus and dialog box buttons or options.
© National Instruments Corporation xiii Getting Results with HiQ
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bold italic Bold italic text denotes a note.

italic Italic text denotes emphasis, a cross reference, or an introduction to a
concept.

monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, parameters, functions, variables, filenames and extensions
for statements and comments taken from programs.

monospace italic Italic text in this font denotes optional parameters or indicates that you m
enter the appropriate words or values in the place of these items.

Related Documentation
The following documents contain information you might find helpful as
you read this manual:

• HiQ Release and Upgrade Notes

• HiQ Reference Manual

• HiQ Online Help, which you can access by selecting HiQ Help Topics 
from the Help menu

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with o
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix A, Customer 
Communication, at the end of this manual.
Getting Results with HiQ xiv © National Instruments Corporation
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Introduction to HiQ

This chapter lists system requirements and installation instructions, 
introduces the HiQ environment, and describes ways in which you can
apply HiQ analysis and visualization to your projects.

System Requirements
HiQ requires the following minimum system configuration:

• Windows 95 or Windows 98/NT 4.0

• 486 CPU with coprocessor

• 8 MB RAM with Windows 95, 16 MB RAM with Windows 98/NT

• 256-color, 800 by 600 VGA display

• 20–60 MB free disk space (You need 20 MB for HiQ Reader, 40 M
for HiQ, and 60 MB for HiQ Professional.)

The following specifications are the recommended system configuratio
for HiQ:

• Windows NT 4.0

• Pentium 90 or higher

• 16 MB RAM with Windows 95, 32 MB RAM with Windows 98/NT

• Accelerated True Color, 1024 by 768 display

• 20–60 MB free disk space (You need 20 MB for HiQ Reader, 40 M
for HiQ, and 60 MB for HiQ Professional.)

Installing HiQ
Use the following procedure to install HiQ:

1. Insert the HiQ CD in the CD-ROM drive of your computer.

2. Follow the Setup instructions you see on your screen.
 Results with HiQ
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By default, the HiQ installation program creates a new folder, C:\Program 

Files\National Instruments\HiQ , that contains the following items:

• Program  folder—HiQ.exe , HiQ help files, and related files.

• Examples  folder—Example Notebooks demonstrating many of the
analysis and visualization capabilities of HiQ, organized by catego

• Readme.txt  file—Late-breaking information about HiQ, known 
limitations, and corrections.

• Manuals  folder—PDF versions of the HiQ manuals.

Note Be sure to read the Readme.txt  file for the latest information about HiQ.

Launching HiQ
Use one of the following methods to launch HiQ:

• Use the Start Button.

1. Click on the Windows Start button and select the 
Programs menu.

2. Select the National Instruments HiQ  submenu.

3. Click on the HiQ icon.

• Use Windows Explorer.

1. Locate the HiQ executable, HiQ.exe , in Windows Explorer.

2. Double click on HiQ.exe .

The HiQ Notebook
HiQ uses a notebook as the basic interface metaphor. The HiQ Notebook 
has features that you normally associate with a real engineering or 
scientific Notebook, such as pages, sections, and tabs. Figure 1-1, HiQ 
Environment, labels all of the interface elements in the HiQ environmen

An Organizational Tool
On a single page you can arrange information in a free-form manner m
like in a typical drawing program. Each piece of information that you pla
on a Notebook page is known as an object. As with a real notebook, you 
can put many types of objects on a page: text, numerics, graphs, and m
HiQ offers these objects plus some that you do not find in a regular 
notebook. In fact, you are not limited to placing HiQ objects on your 
Getting Results with HiQ 1-2 © National Instruments Corporation
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Notebook. You also can place any ActiveX control or object on a Notebo
page, significantly increasing your flexibility within the HiQ environmen

You can interact with objects on a Notebook page in many ways. For 
example, if you have a three-dimensional graph on a Notebook page, 
can rotate it, zoom in or out, and make any number of other changes to
that graph looks.

As your Notebook grows, you can add more pages. You also can group 
work in sections to better organize a project.

Figure 1-1.  HiQ Environment

An Interactive Analysis Environment
The HiQ Notebook includes an object known as the HiQ-Script object.
HiQ-Script is the built-in programming language that allows you to acce
the HiQ library of analysis and visualization functions. 

With a script object on a Notebook page, HiQ emerges as a documenta
tool and an interactive analysis environment. You can build a Noteboo

Objects

Object
Tools

Log Window Status Bar Script Status

Object
List

Notebook
Organization

Notebook
Explorer

Command
Window

ActiveX
Object

Browser

Alignment
Tools

Notebook
Page
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documenting what you have done and bring the analysis to life for you
audience.

HiQ provides an extensive library of analysis and visualization function
With these functions, you can visualize data in 3D objects, solve syste
of ordinary differential questions, and solve many other analytical and 
visualization problems. Often, you can obtain your results using only H
built-in functions; however, when you need something more, you can cr
your own HiQ-Script functions to perform the exact analysis needed fo
your project.

HiQ also includes a comprehensive set of functions from the mathema
disciplines listed in this section. For a complete list of all functions, the
usages, and descriptions as shown in Figure 1-2, refer to the HiQ onli
help or Chapter 7, Function Reference, of the HiQ Reference Manual.

Linear Algebra
HiQ provides comprehensive linear algebra functionality including the 
following items.

• Complete vector and matrix algebra using the natural, intuitive line
algebra syntax in HiQ-Script

• Vector and matrix norms such as Euclidean, Lp, and infinity

• Eigenvalue and eigenvector analysis

• Linear system solvers

• Matrix decompositions such as LUD, SVD, QRD, Schur, and othe

• Vector and matrix transformations

Data Fitting and Interpolation
Data fitting and regression are excellent tools for gaining insight into 
real-world data. HiQ offers a flexible suite of data fitting and interpolatio
tools including the following items.

• Line, exponential, polynomial, and Gauss function data fitting

• Single- and multiple-dimension nonlinear data fitting

• Linear data fitting using a set of basis functions

• Polynomial interpolation

• Spline interpolation including cubic splines, b-splines, and 
polynomial splines
Getting Results with HiQ 1-4 © National Instruments Corporation
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Optimization
With HiQ optimization routines, you can minimize the cost of producing
product, maximize the capital gains in a financial portfolio, or minimize
time required to perform a task. HiQ optimization capabilities include t
following items.

• Nonlinear single- and multiple-dimension optimization

• Linear programming

Statistics
HiQ offers a complete set of descriptive statistics you can use to analy
set of data.

• Mean, standard deviation, variance, covariance, correlation, and m

• Cumulative distribution and probability density functions of severa
types

• Histogram, quartile, and range

Differential Equations
Dynamic systems such as the motion of an object, the results of a chem
reaction, and the reaction of complex economic systems can be descr
by a set of differential equations. HiQ can solve several types of differen
equations including the following types.

• Nonlinear initial-value problems including stiff systems

• Linear and nonlinear boundary-value problems

Nonlinear Analysis
HiQ nonlinear analysis capabilities include the following items.

• Roots of polynomials and nonlinear functions

• Solving a system of nonlinear equations

Integration
HiQ integration capabilities include the following items.

• Data integration

• Nonlinear function integration

• Polynomial integration
Getting Results with HiQ 1-6 © National Instruments Corporation
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Differentiation
HiQ differentiation capabilities include the following items.

• Numeric multiple derivatives and partial derivatives

• Gradient, Laplacian, Jacobian, and Hessian

• Polynomial derivatives

Polynomials
HiQ has a native polynomial object that makes polynomial algebra as e
as linear algebra. With this object you can work with polynomials witho
worrying about the degree. Polynomial algebra and functions return 
polynomial objects and include the following items.

• Complete polynomial algebra using the natural, intuitive polynomia
syntax in HiQ-Script

• All polynomial math including inverse, greatest common divisor, lea
common multiple, and more

• Integration

• Differentiation

ActiveX Environment
HiQ supports ActiveX technologies that allow you to customize Noteboo
and increase productivity. For example, using drag-and-drop you can p
objects on a Notebook from the Notebook Explorer, plot a vector or ma
in a graph, or print a Notebook without launching HiQ. You also can dr
data from Excel into HiQ to create 3D graphs in HiQ. These ActiveX 
technologies let you work in your favorite environments and then collect
of your work in one place—a HiQ Notebook.

Because HiQ is an ActiveX container, you can embed ActiveX objects
such as Word documents and Excel Workbooks, and ActiveX controls
such as National Instruments ComponentWorks, to increase the 
functionality of a HiQ Notebook. Using ActiveX automation from 
HiQ-Script, you can take advantage of the capabilities of a control. Us
ComponentWorks ActiveX controls, you can acquire data directly into 
HiQ Notebook.

Because HiQ Notebooks are ActiveX objects, you can embed a Noteb
as an object in other ActiveX containers. If you must prepare a lengthy
written technical report and prefer using Microsoft Word, you can embe
HiQ Notebook directly in your Word document.
© National Instruments Corporation 1-7 Getting Results with HiQ
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Because HiQ is an ActiveX automation server, you can control HiQ fro
any ActiveX automation client such as LabVIEW, Visual Basic, or your
own C programs. You can create and print customized reports with ana
and graphs directly from another application.

Because HiQ is an ActiveX automation client, you can control other 
applications from HiQ. For example, your Notebook can directly open 
Excel Workbook, extract data, perform analysis, and create a 3D grap

Putting It All Together
Imagine preparing a management study for a water reservoir. To repor
results of your study you might use text to describe the problem, table
data to support your claim, graphs to analyze the data, analysis to form
projections or solutions, and conclusions to suggest ways to better ma
the reservoir in the future. HiQ handles all these reporting, analysis, a
visualization tasks. Furthermore, you can include an interactive script 
graph so your audience can observe the effect of changing variables o
inflow and outflow water levels. This interactive Notebook also become
tool for managing the reservoir in the future.

Experimenting with Example Notebooks
Looking at and experimenting with some example Notebooks gives you
idea of what you can accomplish with HiQ. In this manual, you learn h
to use and create Notebooks to visualize and analyze data. You can br
the Examples  folder, which contains a variety of Notebooks illustrating
the analysis and visualization capabilities of HiQ.

Working with Multiple Windows
A HiQ Notebook uses the standard Multiple Document Interface (MDI
that Microsoft Office products like Word and Excel use. A main window
exists within which multiple HiQ Notebooks may reside. From the 
Windows menu, you can maximize, overlay, or tile the Notebook window
you open.

Interacting with a Notebook and Running Scripts
A well designed Notebook should be self-documenting, describing how
interact with the Notebook. Interaction might be as simple as entering 
start time and a stop time for simulation of a system of differential 
equations. Or a Notebook might instruct you to select a data file to imp
in order to calculate and graph the amount of rainfall in a particular are
Getting Results with HiQ 1-8 © National Instruments Corporation
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Most Notebooks include scripts that you can run to solve the type of 
mathematical or visualization problem the Notebook was designed to 
handle. 

Note To execute a script, right click on the script object and select Run.

Accessing Online Help
HiQ offers tooltips, context-sensitive help, and online help that you ca
access in the following ways.

• You can access the HiQ online help by selecting HiQ Help Topics 
from the Help menu. There you find information not available in thi
manual, such as complete function reference and answers to How 
Do I...? questions.

• Tooltips appear when you move the mouse cursor over a button in
toolbar. The text of the tooltip indicates the function of the button. 

• A help topic appears in the status bar at the bottom of a HiQ Noteb
as you move the mouse pointer over the menu items.

• You can click on the Help button, ?, in other areas of the HiQ user 
interface, such as dialog boxes, to access context-sensitive help fo
next item on which you click.

Note Use the <F1> key to access context-sensitive help for a selected item or for an a
where the cursor is located. For example, when your cursor is located in a scri
within the name of a HiQ built-in function, help for that function appears when 
you press <F1>.
© National Instruments Corporation 1-9 Getting Results with HiQ
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Getting Results with a 
HiQ Notebook

This chapter introduces the fundamental features of the HiQ Notebook
interface and shows you how to interact with existing Notebooks.

Notebook Examples
This section presents two different HiQ Notebooks—a data fitting exam
and an expression evaluator Problem Solver—to demonstrate the use 
HiQ Notebook. The data fitting example, Population Fit, demonstrates h
a Notebook performs a single data analysis, and the Expression Evalu
Problem Solver demonstrates how a Notebook can solve a class of 
problems. A Problem Solver Notebook accepts varied input from user
without requiring them to alter the contents of the script.

Data Fitting Notebook
In this example, you work with a Notebook that performs data fitting 
analysis. The purpose of this example is to present the fundamental 
interface elements in HiQ, general parts of a Notebook, and common 
objects.

This Notebook demonstrates how HiQ analyzes a set of data, in this c
population data, and graphically displays it. More specifically, the 
Population Fit Notebook graphically presents the change in U.S. 
population over time.

This Notebook contains a script and a graph. The script object contain
HiQ-Script code that performs the data fit. The graph object displays t
data fit after the script executes.
 Results with HiQ
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Opening a Notebook
1. To open a Notebook, use the File»Open command.

2. Open the Examples  folder within the HiQ folder. 

The Examples  folder contains Notebooks grouped by category. Lat
you can explore the different examples to get a feel for HiQ 
capabilities.

3. From the Examples  folder, open the Data Fitting  folder and select 
Population  Fit.HiQ .

4. Click on Open. The Population Fit Notebook appears, as shown in
Figure 2-1.

Figure 2-1.  Population Fit Notebook
Getting Results with HiQ 2-2 © National Instruments Corporation
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Running a Script
To run the script, click on the Perform Population Fit run button. The 
output of the script appears as a plot within the graph and represents 
increase of U.S. population over time, as shown in Figure 2-2.

Figure 2-2.  Running a Script in the Population Fit Notebook

Four objects are visible on the Notebook page: the graph, two text box
and the script. However, these are not the only objects in this Noteboo
you will learn in the next section.

Right click on the run button, select View Source, and scroll through the 
script at the bottom of the page to get a feel for how HiQ performs analy
In this example, a single function fit  performs the data fitting analysis. 
You can access most analysis capability in HiQ through calls to single
functions like fit .
© National Instruments Corporation 2-3 Getting Results with HiQ
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Viewing an Object List
Many, but not all, objects in a Notebook appear on the Notebook page
see all objects in the Notebook, perform the following steps in the 
Notebook Explorer.

1. Click on the plus sign (+) to the left of the Notebook name (in this 
example, Population Fit.HiQ ) to expand the contents of the 
Notebook.

2. Click on the plus sign (+) to the left of the word Objects to expand the 
Object List, as shown in Figure 2-3.

Figure 2-3.  Expanding the Object List

The Object List contains all objects in the active Notebook. With the 
exception of the graph and HiQ-Script objects, all the objects in the lis
resulted from the execution of the script. As you can see, objects do n
have to be visible to exist within a Notebook. 

Note Any object created by a script exists in the Notebook and appears in the Object 
after that script runs. The only exception is objects with local scope. See the local 
section of Chapter 6, HiQ-Script Reference, in the HiQ Reference Manual for 
information about local scope.

When HiQ-Script objects are generated, they appear only in the Object 
If you want the object on the Notebook page, select it in the Object List 
drag-and-drop it on the page.

Expression Evaluator Problem Solver Notebook
Problem solvers are HiQ Notebooks designed to interact with users to
analyze or solve a wide range of problems belonging to a certain class.
previous example Notebook, Population Fit, does not qualify as a prob
Getting Results with HiQ 2-4 © National Instruments Corporation
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solver because it solves a single problem. Population Fit does not give
the option to fit populations from different countries or different time 
ranges. In order to analyze a different set of data you would need to mo
the script. A problem solver is a HiQ Notebook that allows the user to e
a different set of data or analysis problem without having to modify scr
The Expression Evaluator Notebook illustrates the problem solver featu
you can use in HiQ. Perform the following steps to learn more about th
Expression Evaluator Notebook.

1. To open a Notebook, use the File»Open command.

2. Open the Examples\Problem Solvers  folder within the HiQ 
folder.

3. Select Expression Evaluator.HiQ  and click Open. The 
Expression Evaluator Notebook appears, as shown in Figure 2-4.

Figure 2-4.  Expression Evaluator Notebook
© National Instruments Corporation 2-5 Getting Results with HiQ
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Entering Data and Running Scripts
This Notebook can evaluate any mathematical expression and display
behavior graphically. Unlike the Population Fit Notebook, objects in th
Expression Evaluator Notebook expect input from a user. The user ent
mathematical expression, the number of points to plot, and the interva
the domain. In this example, all objects have default values so you can
run the Notebook.

1. Click on the Evaluate button to evaluate the expression. The Notebo
evaluates the expression over 128 points, starting at 1 and ending
The graph displays the result.

2. Enter the mathematical expression sin(x)*cos(x)  into the text 
object labeled F(x) =.

3. Click on the Evaluate button to evaluate the expression.

Figure 2-5.  Evaluating Expressions with the Expression Evaluator Notebook
Getting Results with HiQ 2-6 © National Instruments Corporation
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The expression you entered is fed into the numerical algorithm in the sc
The plot that appears when you run the script is a graphical representa
of the mathematical expression sin(x)*cos(x)  that you entered. To 
observe the role of the numeric input of this Notebook, enter various va
for the domain interval and number of plotted points and rerun the scr

Enter other mathematical expressions and run this Notebook to see h
they display. Keep in mind that you must use valid operators and valid H
built-in functions. In this example, your expression must be in terms ofx. 
Consult the HiQ online help or Chapter 7, Function Reference, of the HiQ 
Reference Manual for complete descriptions of operators and built-in 
functions.

Understanding Objects
All the items on a Notebook page are called objects. Notice that any ob
you click on becomes active and displays a border, as shown in Figure
You can interact with any activated object directly on the Notebook pa

Figure 2-6.  Object in Active Mode

What is an object in HiQ? Anything contained within a Notebook is an
object. The following list includes some useful facts about objects.

• An object is associated with a Notebook but is not necessarily visi
on the Notebook page until you place it there.

• All interactive tools of HiQ involve either the Notebook or its objec

• HiQ uses several major categories of objects: numeric, graphic, 
HiQ-Script, text, and ActiveX. Each of the objects in these categor
has a distinct purpose in HiQ.
© National Instruments Corporation 2-7 Getting Results with HiQ
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Deleting Objects and Object Views
Objects in your HiQ Notebooks can exist without being visible on the 
Notebook page. For example, you might want to display the plot of a d
set without displaying the numeric object that is the source of the data

Note Remember the distinction between objects and object views when deleting. You
delete an object entirely from the Notebook or delete only a view of that object fr
the Notebook page.

Deleting the View of an Object from a Page
Deleting the view of an object from the Notebook page is not the same
deleting the object. When you delete a view, the object remains in the
Notebook Object List. You can still access the object through a script o
the Object List.

To delete a view, right click on the object on the Notebook page and use
View»Delete command. Alternatively, you can select the object view an
press the <Delete> key. The selected view is removed from the Noteb
page, but the object remains in the Notebook.

Deleting an Object from a Notebook
To entirely delete an object from a Notebook, right click on the object a
use the Object»Delete command. Alternatively, you can select the objec
view and press <Shift-Delete>. The object and all of its views are remo
completely from the Notebook.
Getting Results with HiQ 2-8 © National Instruments Corporation
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Getting Results with the 
HiQ Command Window

This chapter presents the Command Window. It explains how to navig
the Command Window, get help from the Command Window, create a
modify notebooks from the Command Window, and get immediate res
using the Command Window.

For more information about the HiQ Command Window, see Chapter 2
HiQ Command Window, in the HiQ Reference Manual. For information 
about HiQ-Script, see Chapter 5, HiQ-Script Basics, in the HiQ Reference 
Manual.

Navigating the Command Window
The Command Window provides immediate access to all analysis and
visualization functions in HiQ-Script. If you are looking for quick answe
or you are performing exploratory analysis, use the Command Window
display your results immediately.

To experiment with the Command Window, open a new Notebook. By 
default, the Command Window is attached to the bottom of the HiQ 
window. You can adjust the position of the Command Window by clicki
on the double gray border on the left and dragging it. The window detac
from the bottom frame and becomes a floating window, as shown in 
Figure 3-1.

Note To return the Command Window to its default position, click in the Command 
Window title bar and drag the window toward the bottom of the HiQ window. A
you drag the window, notice the gray frame. When the window is in a position 
where it can be docked in the HiQ window, the frame becomes thinner. When y
see the thin frame, release the mouse button. This procedure works for the 
toolbars and other detachable windows, such as the ActiveX Object Browser a
the Explorer.
 Results with HiQ
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Figure 3-1.  Floating Command Window

The Command Window prompt, >, indicates that the Command Window
ready to receive a command. You can create different objects at the pro
For example, you can create a matrix object named A by typing the 
following command at the prompt:

> A = {1,2,3;4,5,6;7,8,9}

Notice that the Command Window echoes the result:

A=

1 2 3

4 5 6

7 8 9

Note If you do not want the Command Window to display the results, include a 
semicolon after the command.

You can create a polynomial object named p by typing the following 
command at the prompt:

> p = {poly:"x^2+2x+1"}
Getting Results with HiQ 3-2 © National Instruments Corporation
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The value for the polynomial object p is echoed by the Command Window

p = x^2 + 2x + 1

If an object is too large to view in the Command Window, HiQ displays t
object in an individual floating window. For example, create a graph by
typing the following command at the prompt:

> MyGraph = createGraph(A)

Note HiQ highlights all built-in functions, such as createGraph , in blue to indicate 
that you have correctly entered the function name.

HiQ creates a graph named MyGraph of the matrix A and displays the graph
in its own window.

Notice that each HiQ-Script command assigns a new object name, suc
p, A, or MyGraph. All objects in HiQ have a name; however, you do not 
have to name every object you create in the Command Window. For 
example, you can quickly determine the norm of a matrix by typing in t
following command at the prompt:

> norm(A)

The Command Window echoes the result:

ans = 16.848103

Because you did not specify the object name, HiQ chose a default nam
this case, the default object name is ans .

Note You can change the default name in the Command Window property pages. Ri
click in the Command Window and edit the Name option in the Default Object 
Assignment area.
© National Instruments Corporation 3-3 Getting Results with HiQ



Chapter 3 Getting Results with the HiQ Command Window

sue 

he 
and 

w 
he 
he 

s in 
Because the Command Window allows multiline commands, you can is
commands over several lines to help you visually create a matrix or 
organize a script, as in Figure 3-2.

Figure 3-2.  Multiline Commands in the Command Window

You can recall and edit previous commands by using the arrow keys. T
Command Window accepts all special Command Window commands 
all HiQ-Script built-in functions.

Getting Immediate Results with the Command Window
The Command Window offers access to all of the analysis and 
visualization capabilities of HiQ-Script. The following two examples sho
you how to use the Command Window to quickly compute answers. T
first example computes the solution of a linear system of equations. T
second example simulates a system of ordinary differential equations.

Solving a Linear System of Equations
Linear algebra is a widely used area of analysis for describing linear 
dynamic systems, computing the best fit to a set of data, optimizing 
equations, and many other areas. One of the most common operation
linear algebra is solving a system of linear equations.

Consider a set of three linear equations with three unknowns:

1x1 2x2 3x3+ + 6=

4x1 5x2 6x3+ + 2=

7x1 8x2 9x3+ + 7=
Getting Results with HiQ 3-4 © National Instruments Corporation
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These equations can be represented in linear algebra syntax as

where b is a vector containing the values on the righthand side of the 
equations, A is a matrix containing the values of the coefficients on the 
lefthand side of the equations, and x is a vector of unknown quantities.

To create the matrix A and the vector b, type the following at the prompt:

> A = {1,2,3;4,5,6;7,8,9};

> b = {v:6,2,7};

One obvious way to solve this linear algebra equation for the vector x is to 
multiply the vector b by the inverse of the matrix A:

> x = inv(A) * b

This method works only if the matrix A has an inverse. In this case, A is 
singular, and, therefore, it is not invertible. HiQ displays the following 
message to convey this information: The matrix is not invertible  
because it is numerically singular .

Multiplying the vector b on the left by the inverse of A, as above, is 
semantically equivalent to dividing the vector b on the left by the matrix A. 
HiQ uses the backslash operator (\) to indicate left division and choose
appropriate method for solving the equation:

> x = A\b

In this case, the left divide operator is equivalent to calling the built-in 
function solve :

> x = solve(A, b)

Both of the solutions share the same result:

x=–2.027778 0.0555556 2.1388889

Solving a System of Ordinary Differential Equations
Scientists and engineers use differential equations in many areas to 
describe the dynamics of a physical, chemical, or electrical system. H
contains a set of methods for numerically solving first-order ordinary 
differential equations for both initial values and boundary values.

Ax b=
© National Instruments Corporation 3-5 Getting Results with HiQ
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For example, consider a second-order, initial-value system described b
following equations:

These equations describe how two states, x1 and x2, change in time. This 
example solves for the states x1 and x2 as time t moves from 0 to 2. The 
initial value for the states x1 and x2 at time = 0 are 4 and 9, respectively.

ODEIVP is the HiQ built-in function for solving ordinary differential 
equations (initial value problems). To get started, type ODEIVP at the 
Command Window prompt and press <F1> to display the online help f
this function. Study the first function listed under the Usage heading:

[tOut, X] = ODEIVP(fct,x0,start,stop,stepSize,

IVPAlg , absTolr , relTolr , outStep , callback )

Note A HiQ function call consists of a list of input parameters enclosed by parenthes
to the right of the function name and a list of output objects enclosed by squar
brackets to the left of the equal sign.

The first five parameters for the ODEIVP function are required and consist
of a user function that describes the differential equations, a vector 
representing the initial values of the states, a starting value, a stopping
value, and a step size for the solution. The remaining parameters are 
optional. (As a convention, all optional parameters appear in an italic fo

To create the user function for the differential equations, click on the 
parameter fct  in the online help parameter table to view a detailed windo
with a template for the user function fct , as shown in Figure 3-3.

In the Command Window, press the <Esc> key to clear the current 
command. Copy this function (by selecting the text and Edit»Copy) and 
paste (by selecting Edit»Paste) it at the Command Window prompt.

dx1

dt
-------- 5x1– 5+=

dx2

dt
-------- 10x2– 10+=
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Figure 3-3.  Accessing the fct Function Template

Complete the function as follows. Insert the cursor in the last line and 
press <Enter>.

> function fct(t, x)

//t — real scalar

//x — real vector

xdot[1] = –5*x[1] + 5;

xdot[2] = –10*x[2] + 10;

return xdot;

//xdot — real vector

end function;

If you have already pressed <Enter> and need to edit what you typed, r
the function with the up-arrow key and then edit it. After you make you
© National Instruments Corporation 3-7 Getting Results with HiQ
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edits, insert the cursor at the end of the function and press <Enter>. H
creates a user function named fct .

To create the vector of initial values of the states of the two differential
equations, type the following command:

> x0 = {v: 4, 9};

To solve the differential equations starting at 0, ending at 2, and with a
output step size of 0.2, type the following command:

> [t, X] = ODEIVP(fct, x0, 0, 2, .2);

HiQ solves the differential equation and returns the independent solut
values in the vector t  and the solutions to the two differential equations 
the first and second columns of the matrix X.

Finally, visualize the results using the createGraph  and addPlot  
functions:

> g = createGraph(t, X[*,1])

> addPlot(g, t, X[*,2])

The first line creates a new graph named g with a new plot. The second line
adds a new plot to the graph g. HiQ creates a floating view of the graph, a
shown in Figure 3-4.

When you save this Notebook, all of the objects you have created are s
with it. You can load the Notebook later and change the parameters in
differential equations, alter the starting and stopping values of the solut
or place the objects on the Notebook page to create a document. You d
have to recreate results because you save them as you save the Note
Getting Results with HiQ 3-8 © National Instruments Corporation
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Figure 3-4.  Creating an Object View
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Getting Help from the Command Window
When working in the Command Window, you can access the online h
using any of the following methods.

• Press the <F1> key when you are in the Command Window, and t
help for the Command Window is displayed.

• Type a function name at the prompt, place your cursor in the funct
name, and press <F1>. The online help opens the topic information
that function.

• Type help  at the command prompt, and the help for the Command
Window is displayed.

• Type help  keyword at the command prompt, where keyword is the 
function, script keyword, or help file entry for which you are looking
The online help opens the topic information related to the keyword

Getting Notebook Information from the Command 
Window

A Notebook is an organizational tool as well as a documentation tool. H
saves all objects created in a Notebook with the Notebook so you can
access them in a later session to continue your analysis.

This section describes how you can use the Command Window with a
existing Notebook to quickly find answers to questions about Noteboo
data. For this discussion, open and refer to the Command Window.HiQ  
example in the Examples\Getting Results  folder. This Notebook 
contains a matrix of data and a 3D graph representing seismic data 
collected at a seismographic station, as shown in Figure 3-5.
Getting Results with HiQ 3-10 © National Instruments Corporation
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Figure 3-5.  Command Window Notebook

In this example, you create a 2D graph of a signal and compute its ave

Suppose you want to know what happened thirty seconds into the seis
experiment. Specifically, you want to graph the data and calculate the
average. First, you need to extract the desired data from the Seismic m
Type the following command at the command prompt to create a new 
vector of data from row 30 of the Seismic matrix:

> slice = Seismic[30,*]

This line of HiQ-Script creates a new vector object named slice  using 
row 30 and all of the columns of the Seismic matrix. This object is visib
in its own window floating above the Notebook. You can scroll down to
view all elements of the vector.
© National Instruments Corporation 3-11 Getting Results with HiQ
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Although a tabular view of this data is useful, a graph can convey this 
information faster and more effectively. Type the following command at 
prompt to create a graph of slice :

> myGraph = createGraph(slice)

With this command, you have created a new graph object named myGraph 
that displays a plot of the object slice . If you need to make this graph 
larger, resize the window.

To compute the average, or arithmetic mean, of the elements in slice , type 
the following command at the prompt:

> ave = mean(slice)

The new scalar object ave  represents the average of all elements in the 
vector slice . Notice that you can see the ave  object in the Command 
Window immediately after you type the command. To view the ave  object 
in its own window, type the following command at the prompt:

> view ave

To dismiss the floating window view, click on the close box in the title b
of the view. The view  command is one of several Command Window 
commands you can use to manipulate objects from the Command Wind
In the next section, you use the Command Window to modify this 
Notebook.

Modifying a Notebook from the Command Window
The Command Window is a convenient place to create or modify a 
Notebook as you generate results. For example, you can place notebo
views of the objects created in the previous section by using the place  
command. Place the new objects on the page by typing the following 
commands:

> place slice

> place myGraph

> place ave
Getting Results with HiQ 3-12 © National Instruments Corporation
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These commands place three new views on the Notebook: one view f
slice , one view for myGraph, and one view for ave . 

Use the following procedure to move objects on the Notebook page:

1. Right click on the object you want to move and drag the object to a n
position.

2. When you have the object positioned where you want it, release t
right mouse button.

Use the following steps to resize an object:

1. Click on the object to activate it.

2. Position the mouse on the object corner to activate the resize curso
in the following figure.

Figure 3-6.  Resizing an Object

3. Click and drag the object border to the appropriate size.
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Figure 3-7 shows the modified Notebook, which now analyzes and 
documents the results of a seismic experiment. To print this Notebook
a report or hardcopy documentation, use the File»Print  command.

Figure 3-7.  Modifying a Notebook from the Command Window
Getting Results with HiQ 3-14 © National Instruments Corporation
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Getting Your Data into HiQ

This chapter explains how you can get different types of data into HiQ
this chapter, you build two Notebooks—the Climate Notebook and the
Seismic Notebook—and use the Import Wizard to get your data into H
You enhance these Notebooks over the next several chapters.

Many Notebooks you create with HiQ involve analyzing and visualizing
data. Usually this data exists in a file on your hard drive. When you nee
import text or binary data from a file, you can take advantage of the Hi
Import Wizard.

Although you can use the default import settings in most cases, the Im
Wizard allows you to define the data format in your file. When you chan
any of the import setting options in the Import Wizard, the data Preview
window automatically updates to indicate the format of the imported d

Climate Notebook: Importing Data
Over the next several chapters, you build a Notebook that performs a 
fit on climate data from a file. As you conclude each task, save the 
Notebook to use it in the next chapter. If you forget to save, you can s
with a prebuilt Notebook at the beginning of each chapter.

Consider a meteorological data set containing yearly rainfall and 
temperatures. To get this the data into HiQ, import climate.dat  using the 
following steps.

1. Open a new file (File»New) and save the new notebook as 
climate.HiQ  (File»Save As).

2. Select Import Wizard  from the Notebook menu, and click on the 
Browse button.
 Results with HiQ
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3. Select the file climate.dat  in the Examples\Data  folder and click 
on Open. The Preview window displays the raw, unformatted conten
of the file, as shown in Figure 4-1.

Figure 4-1.  Importing Climate Data with the Import Wizard

In this example, the contents of the file are readable because the 
was saved in ASCII format.

4. Click on Next>. On the second page of the Import Wizard, HiQ 
imports a portion of the file and displays the data in the Preview 
window.

On this page, you can change the name of the object (HiQ uses th
filename by default). You also can start importing the data on a row
other than 1, which is useful if the data file contains a header that 
do not want to import. In this example, HiQ ignores the first line 
because it does not contain any numbers.
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5. Select Generate Script and name the script ImportData , as shown in 
Figure 4-2. Although this script is not required to import the data, la
you use it to complete the Notebook as a problem solver.

Figure 4-2.  Generating a Script with the Import Wizard

6. Click on Finish to import the data.

7. Save the Notebook.

Figure 4-3 shows the Climate Notebook with the imported data. The 
climate data, which was imported as a matrix object, is visible on the 
Notebook page. The script generated as a result of the import is not vis
on the Notebook page, but it is listed in the Explorer Object List.

You can move, resize, and modify the appearance of any object on a 
Notebook page. For example, to quickly expand the matrix to display a
its data, right click on the matrix and select Show All Elements. 
© National Instruments Corporation 4-3 Getting Results with HiQ
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Figure 4-3.  Climate Notebook with the Imported Data

Seismic Notebook: Importing Data
Over the next several chapters, you create a Notebook that visualizes
analyzes seismic data from a file. As you conclude each task, save th
Notebook to use it in the next chapter. If you forget to save, you can s
with a prebuilt Notebook at the beginning of each chapter.

Consider a file of binary data representing data collected from a seism
event. Because a raw binary data file contains no format information, 
you must know the structure of the data to successfully import it. In thi
example, the data represents a matrix of values with 100 rows and 
100 columns and was written in IEEE Real 64 format. To import this 
data, perform the following steps.
Getting Results with HiQ 4-4 © National Instruments Corporation
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1. Open a new file (File»New) and save the new notebook as 
seismic.HiQ . (File»Save As).

2. Select Import Wizard  from the Notebook menu and click on the 
Browse button.

3. Select the Seismic.bin  file from the Examples\Data  folder and 
click on Open. The Preview window displays the raw, unformatted 
contents of the file, as shown in Figure 4-4. Scroll through the Prev
window to view the binary data.

Note You might need to select All Files from the Files of type list to display all 
available files.

Figure 4-4.  Importing Raw Seismic Data with the Import Wizard

In this example, the file is not readable because the data is saved 
unreadable binary format. You must first tell HiQ how to format the
data before the Preview window is readable.

4. Click on Next. HiQ recognizes that the file is binary and automatical
selects Predefined: numeric (binary) for the format. 
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5. Click on Next. On the third page, HiQ imports a portion of the file an
displays the data in the Preview window. To verify that the data is 
correct, scroll through the column of numbers. If the data had bee
written using a different binary format, you would have set the corr
Data Type and Byte Ordering options to specify the format.

6. Click on Next. Import this data as a matrix with 100 columns, as show
in Figure 4-5.

Figure 4-5.  Importing Formatted Seismic Data

7. Click on Finish to import the data.

8. Save the Notebook.

Figure 4-6 shows the Seismic Notebook with the imported data. The 
seismic data, which was imported as the matrix Seismic, is visible on 
Notebook page.
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Figure 4-6.  Seismic Notebook with Imported Data

Importing Data as Different Objects
Using the Import Wizard, you can import data in different formats as 
different objects. This section contains procedures for importing data i
text file as a text object or numeric object, importing data in a binary file
a numeric object, and importing data in a custom format with the custo
import option.

Note The Import Wizard dialog box includes advanced settings for formatting data. U
the Next and Back buttons to access all of the options. Click on the Finish button 
in the last option panel to accept all your settings.
© National Instruments Corporation 4-7 Getting Results with HiQ
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Importing a Text File as a Text Object
To import a text file into your Notebook, use the following procedure.

1. Select Import Wizard  from the Notebook menu and click on the 
Browse button.

2. Navigate to the text file you want to import, select it, and click Open.

3. From the Import Wizard, select the appropriate import options. 

a. If the file has a .txt  extension, click on Finish when you are 
ready to import the file.

b. If the file is not a .txt  file, click on the Predefined option and 
select text from the list of predefined formats. Click on Finish 
when you are ready to import the file.

Your text file is now imported as a text object and is accessible through
Object List.

Note Use the data Preview window of the Import Wizard to inspect how HiQ will impo
the data. You might need to modify the import settings to obtain a special form

Importing a Text File as a Numeric Object
To import a text file into your Notebook as a numeric object, use the 
following procedure.

1. Select Import Wizard  from the Notebook menu and click on the 
Browse button.

2. Navigate to the text file you want to import, select it, and click Open.

3. Use the Preview window to ensure that your data is going to impo
correctly. If your data appears correctly in the Preview window, clic
on Finish. Otherwise, follow the remaining steps to customize the 
formatting of your data.

4. To customize the formatting of your text file, click on the Predefined 
option and select numeric (text) from the list of predefined formats. 

5. Click on Next> to select the appropriate delimiter method.

6. Click on Next> again to select the appropriate type of numeric obje
to create.

7. When your settings are complete, click on Finish in the last panel of 
the Import Wizard.

Your text file is now imported as a numeric object and is accessible thro
the Object List.
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Importing a Binary File as a Numeric Object
To import a binary file to your Notebook as a numeric object, use the 
following procedure.

1. Select Import Wizard  from the Notebook menu and click on the 
Browse button.

2. Navigate to the binary file you want to import, select it, and click 
Open.

3. Click on the Predefined option and select numeric (binary) from the 
list of predefined formats.

4. Click on Next> to select the type and byte ordering of your data.

5. Click on Next> again to select the appropriate type of object to crea

6. When your settings are complete, click on Finish in the last panel of 
the Import Wizard.

Your binary file is now imported as a numeric object and is accessible
through the Object List.

Importing with the Custom Import Mode Option
The custom import option is useful when you know how to write impor
formats in HiQ-Script. Refer to the documentation on the import  built-in 
function in the online help.

Note If you need to export data from HiQ, use the Export Wizard, which works similarl
to the Import Wizard. To access the Export Wizard, right click on the object yo
want to export and select Export .
© National Instruments Corporation 4-9 Getting Results with HiQ



© National Instruments Corporation 5-1 Getting
5

l for 
ive 
nce 
 the 

 

ool 
Visualizing Data with 2D and 
3D Graphs

This chapter describes data visualization, which is an indispensable too
communicating results, interpreting your analysis, and gaining an intuit
understanding of what your data represents. In this chapter, you enha
the Climate and Seismic Notebooks with 2D and 3D graphs displaying
data you imported in the previous chapter.

Climate Notebook: Visualizing Rainfall and 
Temperature Data in a 2D Graph

You can graph most data in two dimensions, where the data is plotted
against a single, independent variable. In this example, you plot 
temperature and rainfall data on a 2D graph.

Creating a Graph
1. Open the climate.HiQ  Notebook if you completed the Notebook 

example in Chapter 4, Getting Your Data into HiQ. Otherwise, open 
climate5.HiQ  from the Examples\Getting  Results  folder.

2. To add a 2D graph object to the Notebook, click on the 2D graph t
in the HiQ Tools toolbar.

Note You also can create objects using the Notebook»Create command. For this 
example, select Notebook»Create»2D Graph.
 Results with HiQ
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3. Click and drag on the Notebook page where you want the new gra
to appear, as shown in Figure 5-1.

Figure 5-1.  Clicking and Dragging to Place a 2D Graph Object on a Notebook Page

4. Change the name of the graph object in the Explorer. Select the ob
in the Object List, place the cursor in the object name, and replac
Graph2D_1  with graph  to rename the object.

Plotting a HiQ Data Object
Add a new plot to the graph as described in the following steps. After 
completing the first six steps, compare your New 2D Plot dialog box w
Figure 5-2, which shows the correct settings.

1. Right click on the graph and select New Plot.

2. Select Data as the Range option for your graph and click on the 
Browse button to the right. The range is the y data to plot.
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3. Select climate  from the From Matrix  option, choose Column, and 
type 2. Click OK .

4. Select Data for the x Domain option for your graph and click on the 
Browse button to the right. The domain is the x data to plot.

5. Select climate  from the From Matrix  option, choose Column, and 
type 1. Click OK .

6. Select Generate Script and name the script Plot1 , as shown in 
Figure 5-2. Although this step is not required to plot the data, you c
use this script later to complete the Notebook as a problem solver

Figure 5-2.  Adding a Plot to a Graph

7. Click on OK  to add the new plot.
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Figure 5-3 shows the graph and new line plot, which represents the ye
rainfall for the last 71 years. 

Figure 5-3.  Plotting Climate Data on a 2D Graph

Modifying the Graph and Plot
Many times the reports and presentations you create require graphs w
special formatting. With HiQ, you can format your graphs to match you
needs. In this example, rainfall data might better be represented by a 
graph. To modify the properties of a plot and graph, use the following 
procedure.
Getting Results with HiQ 5-4 © National Instruments Corporation
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1. Right click on the graph and select Properties to access the 2D graph
property pages, as shown in Figure 5-4.

Figure 5-4.  2D Graph Property Pages

2. To modify plot properties, click on the Plots tab to change the plot s
to a vertical bar (Vert. Bar ) in the Style area. This style changes the
plot to a vertical bar plot.

3. To modify graph properties, click on the Graph tab.

4. Enter Austin Climate  for the graph Title .

5. To modify axis properties, click on the Axes tab.

6. In the Axes list box, select xAxis and enter Year  in the Title  field.

7. Set Axes to y1Axis. (y1 denotes the first y-axis. Two-dimensional 
graphs can have up to eight y axes. You use multiple y-axes later 
this chapter.

8. Enter Rainfall (inches)  for the Title  of the y1 Axis.

9. Click on OK .
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Figure 5-5 shows the Climate Notebook with the modified plot. The ba
graph effectively communicates the trend in rainfall totals for 71 years

Figure 5-5.  Climate Notebook After Modifying the Plot

You can add multiple plots to this graph to view the same data in differ
forms or to compare different data sets. In this example, you might wan
add a new plot containing temperature data, as the next section expla

Working with Multiple Plots in a Graph
A HiQ graph can display multiple plots. In this section, you add a new p
of temperature data to the same graph that you created in the previou
section.
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1. Add a second plot of the rainfall data, specifying the third column 
the range of data instead of the second column. Select the Generate 
Script option on the New 2D Plot dialog box and name the script 
Plot2 . Figure 5-6 shows the correct settings for this plot.

Figure 5-6.  Adding a Second Plot to the Graph

Later you use this script to complete the Notebook. To review this 
procedure, see Plotting a HiQ Data Object.

The graph now has a second plot representing the average temper
over the same time period. Because the y-axis is labeled for the rain
plot, we need to add a second y-axis for the temperature data. Th
second axis displays the temperature scale on the right side of the
graph.

2. Right click on the graph object and select Properties.

3. Click on the Plots tab. Select the rainfall plot (Handle)-2  from the 
list of available plots in the Plots property page.
© National Instruments Corporation 5-7 Getting Results with HiQ
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4. On the General tab on the Plots property page, choose y2 Axis as the 
Associated Y Axis, as shown in Figure 5-7.

Figure 5-7.  Adding a Second Y-Axis

5. Click on the Axes property page and select the y2 Axis.

6. Click on the Title tab and name the y2 axis Temperature  
(degrees F) .

7. On the Range tab, set the Mode to Manual with a Minimum  of 50 and 
a Maximum  of 80, as shown in Figure 5-8.
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Figure 5-8.  Setting Range Properties for a Y-Axis

8. Click on OK .

9. Save the Notebook as climate.HiQ .
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Figure 5-9 shows the Climate Notebook with the second plot represen
temperature data. This Notebook effectively presents two related data
with different ranges using multiple y axes on a single graph.

Figure 5-9.  Climate Notebook with Two Related Data Plots

Seismic Notebook: Visualizing Seismic Data 
in a 3D Graph

For many real-world data sets—for example, terrain contours, the mot
of an aircraft in three dimensions, the temperature distribution on a surf
and joint time-frequency analysis—you need to visualize data in three
dimensions. In this example, you create a 3D graph of the seismic dat
Getting Results with HiQ 5-10 © National Instruments Corporation
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Visualizing Data in 3D
1. Open the seismic.HiQ  Notebook if you completed the Notebook 

example in Chapter 4, Getting Your Data into HiQ. Otherwise, open 
seismic5.HiQ  from the Examples\Getting  Results  folder.

2. To add a 3D graph object to the Notebook, click on the 3D graph t
in the HiQ Tools toolbar.

3. Click and drag on the Notebook page where you want to place the 
graph.

4. Drag and drop the Seismic matrix from the Object List in the Explo
to the graph on the Notebook page. When your mouse looks like t
one in Figure 5-10, you can drop the data on the graph.

Figure 5-10.  Using Drag-and-Drop to Plot Seismic Data
© National Instruments Corporation 5-11 Getting Results with HiQ
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Modifying a 3D Graph and Plot
Three-dimensional graphs have all 2D graph properties plus several o
properties of their own. You can access all properties from the Proper
dialog box. For example, you might want to change the color of the surf
plot and project the data to both the XZ and YZ planes.

1. Right click on the graph and select Properties.

2. Select the Graph tab and enter Seismic  Activity  for the graph Title .

3. Select the Axes tab and set the axis titles according to the followin
table:

Note To switch between the axes, select the axis in the Axes list. To set the title for an 
axis, type the axis title in the Title  field.

4. From the Plots page, select the General tab and change the Color Map 
to color spectrum, as shown in Figure 5-11.

Figure 5-11.  Setting the Plot Color Map

Axis Title
x Time (sec)

y Frequency (Hz)

z Magnitude
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5. Click on the Projections tab and select Project to X-Z Plane and 
Project to Y-Z Plane.

6. Click on OK .

7. Save the Notebook as seismic.HiQ .

Figure 5-12 shows a graph similar to the one you have created that disp
data regarding seismic activity as a function of time and frequency. You
experiment with the other 3D property pages—3D and Lighting—to 
become more familiar with the flexibility of display formats for 3D graph

Figure 5-12.  Seismic Notebook with Data Visualized in a 3D Graph
© National Instruments Corporation 5-13 Getting Results with HiQ
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Rotating, Zooming, and Panning a 3D Graph
After putting a 3D graph into active mode, you can change the viewing
position of it using combinations of the mouse, the <Alt> key, and the 
<Shift> key. 

Note Click on a graph object to put it into active mode (the mode for editing the graph
a shaded border appears around the object. If you do not see the shaded bord
the object is probably in selected mode (the mode for sizing and moving the ob
as a whole). Deselect the object by clicking on a blank space in the Notebook p
and then click on the object again to put it into active mode.

To rotate the graph, click and hold anywhere in the graph area and dra
mouse up, down, left, or right to rotate the graph up, down, left, or righ
respectively.

To zoom the graph, click and hold anywhere in the graph area while 
pressing the <Alt> key. Dragging the mouse down zooms the graph in 
dragging the mouse up zooms the graph out.

To pan the graph, click and move the mouse anywhere in the graph ar
while pressing the <Shift> key.
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Analyzing Data with HiQ-Script

This chapter introduces HiQ-Script as an analysis tool. In this chapter, 
analyze the data in the Climate and Seismic Notebooks with HiQ-Scrip
from the Command Window or the Notebook.

HiQ-Script, a programming language built for analysis, has many advan
features to make programming easier. With HiQ-Script, you have acce
to all HiQ built-in analysis functions, plus you have the power to create
your own functions and programs using the HiQ-Script programming 
environment. In the first example, you use HiQ-Script to analyze rainfa
data. In the second example, you use HiQ-Script to compute the energ
a signal.

Climate Notebook: Analyzing Rainfall Data
In this data analysis example, your goal is to add analysis to an existin
Notebook that contains climate data to determine specific statistics, suc
the average yearly rainfall totals and the average temperatures over the
71 years.

You can access HiQ-Script in the Command Window or from a script ob
on a Notebook page. The Command Window returns immediate resul
The script object encapsulates a series of HiQ-Script statements to ex
the analysis and visualization capabilities of a Notebook.

1. Open climate.HiQ  if you completed the Notebook example in 
Chapter 5, Visualizing Data with 2D and 3D Graphs. Otherwise, open 
climate6.HiQ  from the Examples\Getting  Results  folder.

2. To quickly compute the average rainfall and temperature using the
Command Window, type the following two commands.

> averageRain = mean(climate[*,2])

averageRain = 33.042958

> averageTemp = mean(climate[*,3])

averageTemp = 68.302817

HiQ creates two new objects that contain the average of the second
third columns of the climate matrix. The brackets denote the desir
 Results with HiQ
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indices of the matrix, the asterisk denotes all row elements, and th
and 3 denote the second and third columns of the matrix. You can
continue to perform any analysis from the Command Window. 
Although obtaining results from the Command Window might satis
your information needs, you can quickly and easily document the 
results on the Notebook page.

3. Check the Object List in the HiQ Explorer. As shown in Figure 6-1, t
objects you created—averageRain  and averageTemp —are now 
listed. To place any object from the Object List on the Notebook pa
you can drag-and-drop the object from the Explorer to the Notebo
page.

Figure 6-1.  Climate Object List

4. Drag-and-drop the object averageRain  on the Notebook page.

You can resize this object and change any properties. For example
might want to view exactly three decimal places of precision, includi
any trailing zeros.

5. Right click on the averageRain  view, and select Properties. On the 
Numbers page, set the Decimal Places to 3 and uncheck Remove 
Trailing Zeros . Click on OK .
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Setting Default View Properties
You can modify the properties of an object and make them the default
properties so that any new views of an object of that same type have t
properties.

1. Right click on the averageRain  object view and choose 
Defaults»Update Default Properties.

2. Drag-and-drop the averageTemp  object from the HiQ Explorer to the
Notebook page near the averageRain  object. Notice that this new 
view has the same size and decimal places as averageRain .

Figure 6-2 shows the Climate Notebook with the calculated average 
temperature and rainfall. You can print this Notebook to document the
climate statistics over the last 71 years.

Figure 6-2.  Climate Notebook After Analyzing Rainfall and Temperature Data
© National Instruments Corporation 6-3 Getting Results with HiQ
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Looking for Trends
Finally, it might interest you to determine if there was a trend in the yea
rainfall data over the past 71 years. You can detect a simple trend by 
performing a linear data fit of the rainfall data. With the following steps
you can perform a data fit and graph the results.

The built-in functions in HiQ-Script are intuitively named. For example,
you used the built-in function mean to compute the mean (or average) of 
data set. The built-in function for performing a data fit is named fit , and 
the function for adding a plot to a graph is named addPlot .

1. At the Command Window prompt, type fit  without pressing the 
<Enter> key. Notice that fit  turns blue, indicating that HiQ 
recognizes this name as a built-in function.

2. With the cursor placed in fit , press the <F1> key. HiQ displays the 
online help for the fit  function.

This function can perform many kinds of data fits, from simple line
regression to complex multi-dimensional nonlinear fits. Because y
are interested in the actual fitted data points in this example, you 
perform a line fit, which is the first usage listed for fit .

For information about the value of each parameter, scroll down to 
Parameters sections. Notice that the fifth return value returns the 
actual fitted data points.

3. To compute the fitted data, type the following script at the Comma
Window and press <Enter>.

[,,,,fitData]=fit(climate[*,1],climate[*,2],<line>);

The four commas on the left indicate that you do not want the first fo
values returned from the function.

Note HiQ-Script is case sensitive. Make sure you type the script exactly as it appea

4. Close the help window.

5. To add a plot of the fitted data to your graph, type the following scr
at the Command Window and press <Enter>.

fitPlot=addPlot(graph,fitPlot,climate[*,1],fitData);

The parameter fitPlot  is a plot handle you can use to refer to the pl
itself when you want to manipulate it later.

6. Save the Notebook as climate.HiQ .
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Figure 6-3 shows the Climate Notebook, which now displays a plot 
representing the trend in rainfall over the last 71 years.

Figure 6-3.  Climate Notebook Showing Rainfall Trends

Maintaining the Notebook
This Notebook now communicates the rainfall history over the past sev
years, as well as the average rainfall and average temperature. You ca
this Notebook as a report for documentation or as a visual aid for a 
presentation.

If you repeat your analysis only once a year as new data becomes avai
the steps you performed while creating this Notebook might suffice; 
however, if you need to repeat the analysis on a daily basis on many 
different sets of data, these steps might be inefficient. Because you ca
automate analysis in HiQ, you can create a Notebook that analyzes d
when you push a button. You automate this analysis in Chapter 8, 
Converting a Notebook to a Problem Solver.
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Seismic Notebook: Computing the Energy in the Signal
In this example, your goal is to compute the energy present in the seis
data at a particular point in time. Because the seismic data represents
power of the measured signal versus time and frequency, the energy i
signal at a specific time is the integral of the frequency signal at that ti

1. Open seismic.HiQ  if you completed the Notebook example in 
Chapter 5, Visualizing Data with 2D and 3D Graphs. Otherwise, open 
seismic6.HiQ  from the Examples\Getting  Results  folder.

2. Generate a vector representing the actual frequencies in the seism
data. Each column in the Seismic matrix represents the time dom
data at a specific frequency. The first frequency point (the first colu
in the Seismic matrix) is 4 hertz, and the frequencies (columns) ar
separated by 4 hertz increments.

Type the following line of HiQ-Script in the Command Window to 
create a vector of frequencies starting at four, incrementing by fou
and containing as many elements as the Seismic matrix has colum

f = 4 * seq(Seismic.columns);

Note HiQ-Script is case sensitive. Make sure you type the script exactly as it appea

3. Press <Enter>.

4. To compute the energy in the signal at time 30, type the following
script in the Command Window and press <Enter>.

energy = 1/(2*<pi>) * integrate(f, Seismic[30,*])

The answer is echoed back in the Command Window, as shown in
Figure 6-4.
Getting Results with HiQ 6-6 © National Instruments Corporation



Chapter 6 Analyzing Data with HiQ-Script
Figure 6-4.  Seismic Notebook After Computing the Energy in a Signal

5. To find information about the integrate  function, place the cursor in 
the function name and press the <F1> key. 
© National Instruments Corporation 6-7 Getting Results with HiQ
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6. Click on the first usage for integrate . The help for this topic 
appears, as shown in Figure 6-5.

Figure 6-5.  HiQ Online Help Describing the integrate Function

In this usage, integrate  is integrating a data set specified by the 
second parameter with respect to the first parameter.

The data set is row 30 of the seismic data, which represents the 
frequency content of the seismic signal at 30 seconds. The integrate  
function allows you to optionally specify the algorithm to use for 
integrating the data. By default, the parabolic method is used.

7. Close the help window.

Automating the Analysis
To repeat this analysis for any other time, you can recall the line of 
HiQ-Script and change the value 30 to the new time, or you can autom
this analysis so that you can open the Seismic Notebook and compute
results by pressing a button.

1. Place a new script object on the Notebook page using the Script t
on the HiQ Tools toolbar.

2. To compute the energy at time 30, type the following script in the 
Script object as shown in Figure 6-6.

energy = 1/(2*<pi>) * integrate(f, Seismic[30,*]);

Note You can copy and paste this line from the Command Window to the script obje
Getting Results with HiQ 6-8 © National Instruments Corporation
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Figure 6-6.  Adding Script to the Seismic Notebook to Automate Analysis

3. Right click on the script view and select Properties.

4. On the View page, select Run View and type Compute  Energy  for the 
Caption.

5. Click on OK .

6. Drag-and-drop a view of the energy  object on the Notebook page.

7. Run the script by clicking on the Compute Energy run button.

8. Save the Notebook as seismic.HiQ .
© National Instruments Corporation 6-9 Getting Results with HiQ
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Figure 6-7 shows the Seismic Notebook, which now computes and disp
the energy contained in the signal at the thirtieth second. 

Figure 6-7.  Seismic Notebook with Compute Energy Run Button
Getting Results with HiQ 6-10 © National Instruments Corporation
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Taking Advantage of ActiveX

This chapter explains how you can use different ActiveX technologies
HiQ. In this chapter, you enhance the Climate and Seismic Notebooks 
ActiveX components to extend their capabilities.

See Chapter 1, ActiveX Connectivity, in the HiQ Reference Manual for 
information about ActiveX connectivity and how you can use that 
technology in HiQ to communicate with other applications, embed obje
from other applications in HiQ, embed HiQ Notebooks in other 
applications, control other applications from HiQ, control HiQ from oth
applications, and use ActiveX controls in HiQ

ActiveX allows you to customize your Notebook using any ActiveX contr
or object. For example, you can use an ActiveX control to access the 
Internet and download data from the Web or FTP sites in order to graph
analyze them.

ActiveX technologies add flexibility and versatility to your project. HiQ 
offers the following ActiveX technologies.

• ActiveX Document Container—As an ActiveX document container,
HiQ allows you to embed documents and objects from other 
applications directly into your HiQ Notebook. For example, you ca
embed a Microsoft Word file, an Excel spreadsheet, or a PowerPo
presentation directly in your HiQ Notebook. These embedded obje
are editable within the HiQ environment and can be stored within 
HiQ Notebook or linked to an external file on disk.

• ActiveX Document Server—As an ActiveX document server, HiQ 
allows you to embed a HiQ Notebook into any other application tha
an ActiveX document container. For example, you can embed a H
Notebook directly into a Microsoft Word document, an Excel 
spreadsheet, or a PowerPoint presentation. The embedded HiQ 
Notebook is editable within the other application and can be store
within the container document.

• ActiveX Automation Client—As an ActiveX automation client, HiQ 
allows you to run and control other applications from the HiQ 
environment. For example, you can create a HiQ Notebook that 
automatically launches Microsoft Word or Excel and then shares H
 Results with HiQ
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data with the Word document or Excel spreadsheet to produce an
automated report.

• ActiveX Automation Server—As an ActiveX automation server, 
HiQ allows you to run and control a HiQ Notebook from within any
other application that is an ActiveX automation client. For example
you can create a program in another application, such as Microso
Visual Basic, LabVIEW, or LabWindows/CVI, that automatically 
launches HiQ, opens a HiQ Notebook, and sends data to HiQ for 
automated analysis, visualization, and report generation.

• ActiveX Controls Container—As an ActiveX controls container, 
HiQ allows you to embed ActiveX controls directly into your HiQ 
Notebook. These embedded controls can be accessed both 
interactively and programmatically from within the HiQ environmen
For example, you can embed a Microsoft Web Browser or Nationa
Instruments ComponentWorks control directly into your HiQ 
Notebook and then access that control to automatically gather dat
from the Internet or a physical measurement device.

Note There are two types of objects in HiQ: native objects and ActiveX objects.

Climate Notebook: Adding ActiveX Objects
Because HiQ Notebooks are ActiveX containers, you can embed Activ
controls such as National Instruments ComponentWorks controls to ex
the capabilities of your Notebook, including the ability to perform data 
acquisition from HiQ. 

In this example, you add a button to the Notebook that indicates wheth
script performs a data fit on the rainfall data. When the button is on, th
script performs the data fit and plots the data fit. When the button is off,
script removes the data fit plot.

Note To complete this example, you must have ComponentWorks installed on your 
computer. HiQ Professional installs ComponentWorks (with both design and 
run-time licenses), and HiQ installs the ComponentWorks demonstration versio
(run-time license only).

You also can download the ComponentWorks demo version from the National 
Instruments Web site at www.natinst.com .
Getting Results with HiQ 7-2 © National Instruments Corporation
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Adding a ComponentWorks ActiveX Control
1. Open climate.HiQ  if you completed the Notebook example in 

Chapter 6, Analyzing Data with HiQ-Script. Otherwise, open 
climate7.HiQ  from the Examples\Getting  Results  folder.

2. To place an ActiveX control in a Notebook, use the Edit»Insert 
Control  menu.

3. Select CWButton Control  in the Insert Control dialog box, as shown
in Figure 7-1, and click OK . The control is placed on the Notebook 
page.

Figure 7-1.  Insert Control Dialog Box

4. Resize the control as needed.

5. Right click on the new control and drag it if you need to reposition t
control on the page.

6. Right click on the control and choose Rename to name the object 
switch .

Note When you place an ActiveX control in a Notebook, the Notebook enters Active
Design Mode, which allows you to set properties for the control. Some controls
only operate when ActiveX Design Mode is off. To test or operate a control, tu
off ActiveX Design Mode by unchecking ActiveX Design Mode in the Notebook 
menu.

7. Right click on the button control and choose CWButton Control 
(National Instruments) Object»Properties.

The property pages that you see vary depending on the control. H
does not create the property pages for ActiveX controls. The prope
pages of the ActiveX control should clearly document its propertie
and methods.
© National Instruments Corporation 7-3 Getting Results with HiQ
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8. On the Style page, choose the On/Off Toggle button, as shown in
Figure 7-2.

Figure 7-2.  Selecting a Style for the CWButton Control

9. On the Button page, type Perform  Data  Fit  for the Caption 
property. 

10. Click on OK .

Programmatically Accessing the ActiveX Control
You can use the controls’s properties and methods to programmatical
access its capabilities from HiQ-Script. Use the HiQ ActiveX Object 
Browser to explore the methods and properties available in the contro
explained in following steps.

1. From the Command Window, type browse  switch  and press 
<Enter>. You also can right click on the switch object and select 
Browse.

The ActiveX Object Browser is displayed with two lists: the left pan
displays the list of controls in a library with the particular control 
highlighted, and the right pane lists the methods and properties for
highlighted control.

2. Scroll down the methods and properties list in the right pane and se
the Value  property, which you will use to determine the position of th
switch.

Notice the syntax help and the property description for Value  at the 
bottom of the ActiveX Object Browser. Use this information to acce
the control from HiQ-Script.
Getting Results with HiQ 7-4 © National Instruments Corporation



Chapter 7 Taking Advantage of ActiveX

nd 
t 
3. Place a HiQ-Script object on the Notebook.

4. To perform the data fit on the rainfall data when the switch is on a
remove the plot when the switch is off, type the following HiQ-Scrip
in the new HiQ-Script object.

//If switch is on, calculate the fit and plot it

//on the graph.

if switch.value == 1 then

[,,,,fitData] = fit(climate[*,1],climate[*,2]);

fitPlot = 

addPlot(graph,fitPlot,climate[*,1],fitData);

else

//If switch is off, remove the fit plot. 

removePlot(graph,fitPlot);

end if;

5. Right click on the script and select Properties. On the View page, 
select Run View and type Compute  Fit  for the Caption, as shown in 
Figure 7-3.

Figure 7-3.  Setting View Properties for a Script Object

6. Click on OK .
© National Instruments Corporation 7-5 Getting Results with HiQ
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7. Run the script to plot and analyze the data. Notice the linear data f
the graph. You can remove the plot by clicking on the switch object a
running the script again.

8. Save the Notebook as climate.HiQ .

Figure 7-4 shows the Climate Notebook with the CWButton control. 

Figure 7-4.  Climate Notebook with a ComponentWorks ActiveX Control

Adding a Microsoft Word Document
You also can embed ActiveX documents such as a Word document, a
Excel spreadsheet, or PowerPoint slides in your Notebook. For this 
Notebook, add a Word document to summarize conclusions about this
Notebook.
Getting Results with HiQ 7-6 © National Instruments Corporation
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Note To complete this example, you must have Microsoft Word installed on your 
computer.

1. To place an ActiveX object in a Notebook, use the Edit»Insert Object 
menu item.

When you insert an ActiveX object, you can either link the object to
existing file or embed a new object directly in HiQ. In both cases, t
object appears on the Notebook page. While an embedded object
stores its data in a Notebook file, a linked object does not. When a
linked object file changes, the object displayed in the HiQ Noteboo
automatically updates. However, if the linked object file outside of t
Notebook is moved or deleted, the object within the Notebook is n
longer visible in HiQ.

2. Select a Microsoft Word Document object and the Create New 
option, as shown in Figure 7-5.

Figure 7-5.  Insert Object Dialog Box Lists ActiveX Objects You Can Insert in HiQ

3. Click on OK  to insert a new Microsoft Word document.

4. Use the power of the embedded Word document to enter and form
text. For this example, type the following text:

The average yearly rainfall is increasing, while the average 
temperature is remaining steady.

5. When you finish entering and formatting your text, click on the 
Notebook page (outside of the Microsoft Word Document object).

6. Save the Notebook as climate.HiQ .
© National Instruments Corporation 7-7 Getting Results with HiQ
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Figure 7-6 shows the Climate Notebook with the embedded Microsoft 
Word Document. 

Figure 7-6.  Climate Notebook with an Embedded Microsoft Word Document

Seismic Notebook: Adding a ComponentWorks Control
In this example, you add a ComponentWorks Slide control that specifi
which algorithm to use for computing the energy in the signal.

Note To complete this example, you must have ComponentWorks installed on your 
computer. HiQ Professional installs ComponentWorks (with both design and 
run-time licenses), and HiQ installs the ComponentWorks demonstration versio
(run-time license only).
Getting Results with HiQ 7-8 © National Instruments Corporation
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You also can download the ComponentWorks demo version from the National 
Instruments Web site at www.natinst.com.

Adding an ActiveX Control
1. Open seismic.HiQ  if you completed the Notebook example in 

Chapter 6, Analyzing Data with HiQ-Script. Otherwise, open 
seismic7.HiQ  from the Examples\Getting  Results  folder.

2. To place an ActiveX control in a Notebook, use the Edit»Insert 
Control command.

3. Select CWSlide control, and click on OK .

4. Right click on the slide and choose Rename. Rename the object 
method .

5. Right click on the slide and drag it if you need to reposition the cont
on the page.

You can specify which numerical integration algorithm you want to use
with the Slide control. HiQ uses two methods to compute the integral o
data set: spline  and parabolic . Refer to the integrate topic in the online 
help for more information about these methods. Complete the followin
steps to modify the Slide control properties.

6. Right click on the slide and choose CWSlide Control (National 
Instruments) Object»Properties. The control generates these 
property pages so you can customize the control.

7. On the Style page, choose Vertical Slide and Value pairs only for 
the Style, as shown in Figure 7-7.
© National Instruments Corporation 7-9 Getting Results with HiQ
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Figure 7-7.  Setting Style Properties for the ComponentWorks Slide Control

8. On the Pointer page, choose None for Fill Style.

9. On the Value Pairs page, delete all but two value pairs in the list. 
Change one of the pairs’ name to spline  and value to 0, and change 
the other’s name to parabolic  and value to 1.

10. Click on OK .

11. Resize the control as needed.

Programmatically Accessing the ActiveX Control
To access the value of the slide, use the Value  property. Because the 
integrate  function expects a HiQ Constant as the third parameter to
specify the method, you need to write a short user function to return th
appropriate HiQ Constant based on the actual value of the slide.

1. Right click on the Compute Energy run button and choose View 
Source. The object containing the HiQ-Script is now visible in its ow
window.

2. To determine the HiQ Constant for the integration method using th
slide, add a user function to the end of the script object as follows

function getMethod()

//Project declares that the object is defined

//outside this function.

project method;

//Choose the appropriate HiQ constant based on the

//value of the method object.

select method.value from
Getting Results with HiQ 7-10 © National Instruments Corporation
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case 0:

return <spline>;

case 1:

return <parabolic>;

end select;

end function;

To extend your analysis, you can include user functions in your 
HiQ-Scripts. For example, the user function getMethod  returns the 
correct HiQ constant given the position of the slide. This function is no
automatically executed when you run the script. It is executed only wh
called as a function from elsewhere in your script. In fact, you can write 
function in a separate script object if you do not want to include it in th
script that computes the energy. The next step references this function i
call to integrate .

3. To compute the energy with the specified integration method, mod
the call to the built-in function integrate  at the top of the 
HiQ-Script.

energy = 1/(2*<pi>) * integrate(f, Seismic[30,*], 

getMethod());

The third parameter to the function integrate  is a call to the user 
function getMethod . In the previous step, you defined this user 
function to return the HiQ constant <spline>  or <parabolic> , 
depending on the position of the slide. Figure 7-8 shows the comple
script.

Figure 7-8.  HiQ-Script Accessing the User Function getMethod

4. Close the Script window.
© National Instruments Corporation 7-11 Getting Results with HiQ
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5. Execute the script twice, using each integration algorithm to see h
the algorithms affect the energy computation.

To display more precision in the answer, change the Decimal Places 
property in the property pages for the energy object.

6. Save the Notebook as seismic.HiQ .

Figure 7-9 shows the Seismic Notebook with the ComponentWorks Sl
control, which controls the integration method used.

Figure 7-9.  Seismic Notebook with the ComponentWorks Slide Control
Getting Results with HiQ 7-12 © National Instruments Corporation
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Converting a Notebook to a 
Problem Solver

This chapter introduces problem solving Notebooks, which are useful to
for analyzing different data or performing different analysis on a specif
data set. In this chapter, you complete the Climate and Seismic Noteb
by converting them to Problem Solvers that can analyze a variety of 
different data sets.

A Problem Solver is a Notebook that is flexible enough to work with 
different data or perform different analysis on a specific data set when 
press a button. For example, a custom HiQ Notebook might be able to
compute the best exponential data fit to the growth of a specific stock p
in a specific file, but you would need to modify the Notebook if you want
a different type of fit or a different data file. A Problem Solver Noteboo
allows you to choose the data file and the type of data fit to perform with
having to redesign the Notebook.

Climate Notebook: Converting to a Problem Solver
In Chapter 7, Taking Advantage of ActiveX, you completed a Notebook that
analyzed specific rainfall data. In the following Notebook example, you
convert that Notebook to a Problem Solver that allows you to choose t
data file, graph the data, and compute the mean and standard deviatio
when you press a button.

1. Open climate.HiQ  if you completed the Notebook example in 
Chapter 7, Taking Advantage of ActiveX. Otherwise, open 
climate8.HiQ  from the Examples\Getting  Results  folder.

In previous chapters, you imported data, graphed the data, and fin
analyzed the data. However, you can automate this process with 
HiQ-Script so you can quickly repeat your analysis with another d
file. This Notebook already contains a script object that computes 
data fit. You can modify this script to import a data file and comput
averages as well.
 Results with HiQ
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2. To edit the script represented by the Compute Fit run button, right 
click on the button and choose View Source.

A floating window containing the script appears, as shown in 
Figure 8-1. You can position and size this window.

Figure 8-1.  Climate Notebook Script Displayed in a Floating Window

3. Select Compile All Scripts from the Notebook menu to compile all 
the HiQ-Scripts in this Notebook. This step compiles the previousl
generated scripts, Plot1 , Plot2 , and ImportData , and creates three
new functions, Plot1_Run , Plot2_Run , and ImportData_Run .

4. Edit the script object to import and graph the data by typing the 
following lines at the beginning of the script:

//Import the climate data file.

ImportData_Run();

//Remove all plots from the graph.

removePlot(graph);

//Plot the rainfall data in the second column.

Plot1_Run();

//Plot the temperature data in the third column.

Plot2_Run();

5. Change the rainfall plot to a vertical bar by typing the following line

//Change the rainfall plot to a vertical bar.

graph.plot(-1).style = <verticalbar>;

6. Associate the temperature plot with the second y-axis and change
y-axis range:

//Associate the temperature plot with

//the second y axis.

graph.plot(-2).yaxis = 2;
Getting Results with HiQ 8-2 © National Instruments Corporation
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//Set the range of the second y axis.

graph.axis.y(2).range.min = 50;

graph.axis.y(2).range.max = 80;

7. Compute the mean of the rainfall and temperatures by typing the 
following lines:

//Compute the average rainfall and temperature.

averageRain = mean(climate[*,2]);

averageTemp = mean(climate[*,3]);

Figure 8-2 shows the final script in the script window.

Figure 8-2.  Climate Notebook Final Script

8. Close the script window.
© National Instruments Corporation 8-3 Getting Results with HiQ



Chapter 8 Converting a Notebook to a Problem Solver

, 
ta fit 
9. To test the Notebook, run the script by clicking on the Compute Fit 
run button and selecting the climate.dat  data file.

10. Save the Notebook as climate.HiQ .

Figure 8-3 shows the Climate Notebook, which now imports a data file
graphs the data, computes the averages, and optionally performs a da
when you press the Compute Fit run button.

Figure 8-3.  Climate Notebook as a Problem Solver
Getting Results with HiQ 8-4 © National Instruments Corporation
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Seismic Notebook: Converting to a Problem Solver
In Chapter 6, Analyzing Data with HiQ-Script, you completed a Notebook
that computed the energy contained in a joint time-frequency 
representation of a seismic data set at a particular time. In the followin
example, you convert that Notebook to a problem solver that allows yo
choose the time value to compute the energy when you press the Compute 
Energy run button.

1. Open seismic.HiQ  if you completed the Notebook example in 
Chapter 7, Taking Advantage of ActiveX. Otherwise, open 
seismic8.HiQ  from the Examples\Getting  Results  folder.

2. Place a new integer scalar object on the Notebook page and 
rename itt .

3. Right click on the Compute Energy run button and select 
View Source.

4. To compute the energy at the time specified by the integer scalar 
object, modify the first line of the script by replacing 30 with t .

energy = 1/(2*<pi>) * integrate(f, Seismic[t,*], 

getMethod());

5. Close the script window. 

6. To recompute the energy at the specified time, enter a time in the
t object. For this example, enter 50 and click on the Compute Energy 
run button.

The energy object updates its value according to the time you 
specify in t .

7. Save the Notebook as seismic.HiQ .
© National Instruments Corporation 8-5 Getting Results with HiQ
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Figure 8-4 shows the Seismic Notebook, which serves as a Problem So
that computes the energy at any time t  using either of the integration 
methods.

Figure 8-4.  Seismic Notebook as a Problem Solver
Getting Results with HiQ 8-6 © National Instruments Corporation
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Sharing Notebooks with Others

This chapter describes how you can distribute HiQ Notebooks to 
effectively communicate your data analysis and visualization with othe

If you want to share the information in your HiQ Notebooks, you can fre
distribute your Notebooks and the HiQ Reader. The HiQ Reader enab
others to view your Notebooks and run scripts but protects your Noteb
from changes. You also can create and distribute help files for individu
Notebooks.

Note You must use the HiQ Professional version to create Notebooks that others ca
view in the HiQ Reader.

About the HiQ Reader
The HiQ Reader enables users to interact with a HiQ Professional 
Notebook, run scripts, and print and save the Notebook. The HiQ Rea
does not allow users to create new objects, delete objects, or modify t
format of the Notebook. Accordingly, the HiQ Reader does not have a
Command Window and several options have been disabled or remove
from the menus. You also will notice a limited Notebook Explorer windo

You can distribute the HiQ Reader for free from either your HiQ 
Professional CD or from the National Instruments Web site at 
www.natinst.com .

If you are creating a Notebook for distribution, you can preview the file
the HiQ Reader to make sure it looks and functions as you expect it to

Climate Notebook: Previewing the Notebook in the HiQ Reader
In the following example, you test the Climate Notebook in the HiQ Rea
and save it as a HiQ Reader Notebook.

1. Open climate.hiq  if you completed the Notebook example in 
Chapter 8, Converting a Notebook to a Problem Solver. Otherwise, 
open climate8.hiq  from the Examples\Getting Results  folder.
 Results with HiQ
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2. Choose File»Open in HiQ Reader. The HiQ Reader launches and th
Notebook is opened.

Note You must save Notebooks with HiQ Professional before the Open in HiQ Reader 
option is available.

3. Verify that the Notebook performs as expected. Try running the sc
and viewing data.

4. Save the Notebook as climate.hqr . The .hqr  extension indicates 
that the Notebook is a HiQ Reader Notebook. You can still open a
modify the Notebook in HiQ Professional; however, the new extens
will launch HiQ Reader when you double click the Notebook.

Distributing ActiveX Controls in Your Notebooks
If you take advantage of ActiveX controls in distributable Notebooks, 
remember that users need those ActiveX controls installed on their 
computers to use the Notebooks as you have designed them. If the Act
controls are not installed on their computers, the Notebook will open b
will not be behave as intended.

For example, the Climate Notebook uses a ComponentWorks ActiveX
Button control. For users to view the Climate Notebook correctly, they n
the ComponentWorks ActiveX user interface controls installed on their
computers. You can distribute the demonstration version of the 
ComponentWorks ActiveX controls with the Notebook if users do not ha
ComponentWorks. 

Note The HiQ Reader automatically installs a demonstration version of 
ComponentWorks. The demonstration version of the ComponentWorks user 
interface controls is freely distributable and includes a run-time license. You als
can freely download the demonstration version from the National Instruments 
Web site (www.natinst.com ). 

Refer to the license agreements of all ActiveX controls that you intend to use 
and/or distribute with your Notebooks to verify that you have the correct run-tim
and design-time licenses and whether you have permission to distribute the 
controls to others.
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Automatically Executing Functions
To make your Notebooks easier to use and prevent users from having
perform the same steps every time they open, save, or close your Noteb
you can include user functions that automatically execute as users op
save, or close your Notebook. For example, if you create a Notebook 
uses a combobox control to hold a collection of options, you need to w
a function to initialize the combobox with the appropriate options ever
time the Notebook is opened (combobox values are not saved when t
Notebook is saved or closed).

To automatically initialize the controls, you can write a user function cal
onOpen. The following example initializes a Microsoft Forms 2.0 
combobox control every time the Notebook is loaded.

function onOpen()

assume project;

myComboBox.additem("Select One…");

myComboBox.additem("Low Pass");

myComboBox.additem("Band Pass");

myComboBox.additem("High Pass");

end function;

HiQ automatically executes three user functions: onOpen, onSave , and 
onClose . When these functions exist in your Notebook, they are execu
when the Notebook is opened, saved, or closed, respectively.

Distributing Help for a Notebook
You can create and distribute help for individual Notebooks to provide
general information about the Notebook, such as its background and 
purpose. The help can contain any information that you do not want to
include in the Notebook itself.

If there is a file in the same directory as the active Notebook with the sa
name but with an extension of .htm , .chm , or .hlp , you can access this 
help from the Help menu by selecting Help for Current Notebook. HiQ 
supports several types of help formats:

• HTML Help (.htm  or .html )—Use any editor or Web page creation
software to build the HTML file. When you distribute help as a We
page, remember to include all graphics files and secondary pages
you link to from the main help page.
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• Microsoft Compiled HTML Help (.chm  and .chh , if you include a 
Contents file)—Use a tool such as Microsoft HTML Help Worksho
to create a collection of Web pages and compile them into a single
distributable file.

• Windows Help (.hlp  and .cnt , if you include a Contents file)—Use
a WinHelp development tool, such as Microsoft Help Workshop, to
compile several RTF files into a single distributable file.

Note When you distribute Notebooks that have help, be sure to include all necessar
files, including graphics files. Users can access your help file through the HiQ 
Reader Help menu (Help»Help For Current Notebook).

Climate Notebook: Maintaining the HTML Help File
In Chapter 8, Converting a Notebook to a Problem Solver, you completed 
a Notebook that analyzed specific rainfall data. As a Problem Solver, 
Notebook can be reused to analyze new data files. In the following 
example, you modify an HTML file that describes how to use this 
Notebook.

1. Open climate.hiq  if you completed the Notebook example in 
Chapter 8, Converting a Notebook to a Problem Solver. Otherwise, 
open climate8.hiq  from the Examples\Getting Results  folder 
and save it as climate.hiq .

2. Choose Help»Help for Current Notebook. HiQ opens the 
climate.htm  file located in the same directory as the climate.hiq  
Notebook. This Web page briefly describes the purpose of the 
Notebook and the format of the input data file.

3. Click data file to view the actual input data file. This shows an 
example of the correct data file format used by the Notebook.

4. Open climate.htm  in a text editor or Web authoring tool.

5. To add a new paragraph of text with a link to the HiQ help file, type 
following text at the bottom of the file climate.htm .

<p>Refer to the <a href="file:///C.../Program 
Files/National Instruments/HiQ Pro 4.1/ 
Program/HiQ.hlp">HiQ help</a> to learn more 
about HiQ.

Note You need to specify the correct path to HiQ.hlp  file in the above link.

6. Save and close the file.
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7. Choose Help»Help for Current Notebook. The text and a new link 
are now visible at the bottom of the HTML help page.

8. Click on HiQ help to access the HiQ online help.

You can add any information to this Web page that you feel is importan
users of this Notebook.

Seismic Notebook: Viewing Compiled HTML Help
In Chapter 8, Converting a Notebook to a Problem Solver, you completed 
a Notebook that computed the energy contained in a joint time-freque
representation of a seismic data set at a particular time. As a Problem
Solver, this Notebook can be reused to analyze new data files. In the 
following example, you inspect a compiled HTML help file that describ
how to use this Notebook.

1. Open seismic.hiq  if you completed the Notebook example in 
Chapter 8, Converting a Notebook to a Problem Solver. Otherwise, 
open seismic.hiq  from the Examples\Getting Results  folder 
and save it as seismic.hiq .

2. Choose Help»Help for Current Notebook. HiQ opens the 
seismic.chm  file located in the same folder.

The help system for this Notebook was created using Microsoft HTM
Help Workshop. Using the workshop, you can create a series of HT
help files and compile them into a single file for distribution with you
Notebook.
© National Instruments Corporation 9-5 Getting Results with HiQ
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Getting Results as a 
MATLAB User

This chapter summarizes the MATLAB to HiQ transitional tools—such
the HiQ Command Window, the automated M-file to HiQ-Script translat
and HiQ-Script for MATLAB users—and describes how MATLAB user
can use these HiQ features to leverage work they have already done 
in MATLAB.

About HiQ
HiQ is designed specifically for scientists, engineers, and technical 
professionals. It offers flexible graphics for data visualization and includ
a mature analysis library and scripting language that handles the rigor
requirements of current problem solving. The intuitive, natural user 
interface encourages the use of all the powerful capabilities in HiQ with
the difficulties of traditional programming packages. In fact, this 
ease-of-use approach is the defining factor that separates HiQ from o
analysis and data visualization packages.

Traditionally, when you changed from one analysis package to another,
encountered incredible obstacles, such as learning the features in the
package, transferring all work previously done in the prior package, fix
problems created by the transfer, and implementing functionality availa
in the old version that is not available in the new version. With HiQ 4.0, y
will find transitioning to the HiQ environment easier than ever.

HiQ offers a transitional approach that allows you to continue working 
while learning the HiQ environment. Features that support this approa
include the following:

• HiQ Command Window—The HiQ Command Window provides 
two interface modes: a HiQ mode that exploits all HiQ features an
100% MATLAB 5 compatibility mode using your installed version o
MATLAB 5 or greater.
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• Automated M-file to HiQ-Script Translator—The translator and 
translation library are integral in supporting your progress in movin
from MATLAB to HiQ.

• HiQ-Script—The HiQ-Script language is a programming language
specifically designed for analysis. HiQ-Script is comparable to 
MATLAB M-file programming but contains additional programming
constructs and built-in data types.

• HiQ Online Help for MATLAB Users—The online help is always 
available by pressing the <F1> key.

The goal of this chapter is to present ways in which HiQ and MATLAB c
be used together. This chapter offers MATLAB-to-HiQ transition avenu
to help you migrate at your own pace while still making optimal use of yo
previous work and valuable time.

HiQ Command Window
In MATLAB, you use the command line interface to interact with your 
analysis results. Because you can use the HiQ Command Window exa
as you do in MATLAB, you can get acquainted with HiQ while you 
continue to use the data and M-files you have already created in MATL

Accessing the HiQ Command Window
After starting HiQ, access the command line feature by opening the 
Command Window. Verify that the Command Window option in the 
View menu is checked. If not, select it.

If you are running HiQ for the first time, the Command Window appears
the lower section of the HiQ window. If you have used HiQ or moved t
Command Window before, it appears in the last position it was placed

At the top of the Command Window, you should see a > prompt, which is 
the prompt used by the HiQ command line while in HiQ mode. In the n
section, you switch to MATLAB mode.
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Accessing and Using MATLAB 5 Compatibility Mode

Note To complete this example, you must have MATLAB 5 or greater installed on yo
computer.

At the HiQ Command Window prompt, type the following command:

> matlab

After a few seconds, the MATLAB prompt, », appears.

Note Because the installation of MATLAB version 5.0 does not automatically registe
the application with the operating system, you might see the following error 
instead of the MATLAB prompt:

Error:Unable to launch MATLAB. Verify that MATLAB is 

properly installed.

If you receive this error, start MATLAB from the operating system with the 
following option:

MATLAB.exe /regserver

This option registers MATLAB with the operating system so other applications
including HiQ, can communicate with it. 

Exit MATLAB and return to HiQ. Execute the matlab  command again in the 
Command Window to get the MATLAB prompt.

Once you enter MATLAB mode, you can work as if you were in MATLAB
For example, you can perform all of the following tasks:

• Execute your existing M-files by typing in their name and associat
parameters.

• View the data objects by typing in their name and pressing return.

• Create and manipulate any data objects with the MATLAB 
programming language.

• Run any command defined in the MATLAB command line interfac
© National Instruments Corporation 10-3 Getting Results with HiQ
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For example, try the following commands:

» x = eye(2)

» x

» size(x)

» x(2,2) = 5;

» cd

» help inv

» y=inv(x);

» sqrt(y)

Notice that information is displayed exactly as it is in MATLAB. The inv  
and sqrt  functions used in this example are also HiQ built-in functions. 
HiQ mode, the names of these functions are highlighted in blue to clea
indicate that you are calling a HiQ built-in function.

Try experimenting with various MATLAB commands. When the HiQ 
Command Window is in MATLAB compatibility mode, you have access 
all MATLAB commands and programs from within HiQ.

The next section concentrates on sharing data and programs between
and MATLAB using the MATLAB compatibility mode of the HiQ 
Command Window.

Sharing Data and Functionality
You have already seen an example of HiQ using MATLAB functionalit
with the inv  and sqrt  functions. However, this capability is not limited to
functions shipping with MATLAB. Any M-file created by you or your 
colleagues is accessible using the same approach. In addition to runn
programs, you also can share data between HiQ and MATLAB.

To allow data transfer between applications, four commands have bee
added to the MATLAB mode: get , getall , put , and putall . With these 
commands, you can share any numeric or textual data created by eith
application.

• get  X—Copies the variable name X from the current MATLAB 
workspace to an object in the active HiQ Notebook.

• getall —Performs a get  on all variables in the MATLAB workspace

• put  X—Copies the HiQ object named X from the active HiQ Notebook 
to the current MATLAB workspace.

• putall —Performs a put  on all HiQ objects in the active HiQ 
Notebook.
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At the MATLAB prompt, type the following commands.

» r = rand(50);

» h = surf(r)

Note When using MATLAB handle graphics, the get(h)  function still operates as 
expected.

A new window has been generated by MATLAB and named Figure  1. It 
contains a static representation of the random surface. Now, get the d
from MATLAB to HiQ and graph it in HiQ with the following commands

» get r

» hiq

The hiq  command switches the interface mode from MATLAB to HiQ. 
Notice that the prompt changes (from » to >) when you switched modes. 
The remaining commands in this example are native HiQ commands.

> graph = createGraph(r)

> view graph

The result is a HiQ graph object that contains a dynamic representatio
the random surface. For comparison, change the color map for the plo
color spectrum using the Graph property page. You can access the pro
page by right clicking on the graph and selecting Properties. To rotate the 
HiQ graph, click on the graph and drag.

Look at the data used to generate the graphs. In MATLAB mode, you t
in the name of the variable, r , and press <Enter>. If you want to see only
portion of r , you index the variable for the range of interest. Unfortunate
this creates a new temporary object (inans ) and takes up MATLAB 
workspace. In HiQ mode, however, you have two options:

• Use the command line view, which provides results similar 
to MATLAB.

> r

• Create a view of the object, which creates a window r  that looks 
similar to an Excel spreadsheet. You can scroll through the elemen
the matrix r  using the scroll bars at the right and bottom. To edit 
individual values, highlight the cell and input a new value. For 
example, use this matrix view to change the corner elements of th
matrix to 5.

> view r
© National Instruments Corporation 10-5 Getting Results with HiQ
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After editing the matrix, send the changes back to MATLAB and regra
the matrix to view the edits.

> matlab

» put r

» surf(r)

Notice that the four corners of the surface are spiked because the large
values were added to the matrix.

Accessing and Using HiQ Mode
To change the HiQ Command Window from MATLAB mode to HiQ 
mode, type the following at the command prompt:

» hiq

Several commands, such as cd , pwd, ls , and dir , are identical in the HiQ 
Command Window and MATLAB. MATLAB makes no distinction in 
M-files between command line commands and built-in functions. In Hi
commands are not built-in functions. HiQ commands are valid only in 
HiQ Command Window. 

Use HiQ commands as you would operating system commands. For 
example, delete  objectName  frees the resources used by the object wi
the given name.

By treating commands differently from built-in functions, you can creat
user-defined functions in your scripts using the same names as the 
commands without limiting the use of either one in the Command Wind
If the command name is the same as an object name, command overw
occurs as it does in MATLAB. To continue using the command in this 
situation, precede the command with the pound sign (#). The first two li
treat cd  as a scalar, while the last executes the cd  command.

> cd = 5;

> y = 3 * cd;

> #cd

Many commands in the Command Window control other features of H
such as the HiQ Notebook. The HiQ Notebook, the primary interface 
element in HiQ, provides a framework for analyzing, visualizing, and 
documenting solutions. You can think of the HiQ Notebook as an extens
of the project notebook kept by an engineer or scientist with sections, 
pages, drawings and algorithms.
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In HiQ, you can have multiple notebooks open at one time solving multi
problems. Each notebook has its own collection of objects and results
this type of environment, the Command Window must attach to a partic
notebook to allow the command line interface to alter the objects in th
notebook. You must detach the Command Window to perform work 
independent of a notebook. For more information about attaching and
detaching, see Chapter 2, HiQ Command Window, in the HiQ Reference 
Manual.

Frequently Asked Questions
The following questions address issues you might encounter while in H
mode. For a complete description of the HiQ Command Window and i
commands, see Chapter 2, HiQ Command Window, in the HiQ Reference 
Manual.

How can I stop variables from displaying their contents when I execute 
a statement?

HiQ offers two display modes: terse and verbose. The Command Wind
is in verbose mode by default. If you prefer the MATLAB approach, yo
can set the Trailing  semicolon implies terse mode option for the 
Command Window. Right click in the Command Window, select 
Properties, and set this property.

Where can I get help on a built-in function?

As in MATLAB mode, type help  followed by the function name, or place
the cursor in the text of the function name and press the <F1> key.

How do I clear a variable from my workspace?

To remove an object created by the Command Window, you can delet
from the Object List in the HiQ Explorer or use the delete  command in 
the Command Window.

How can I display the variables that were affected by the last command 
line execution?

The whatChanged  command provides a list of all HiQ objects changed b
the execution of the last line in the Command Window.
© National Instruments Corporation 10-7 Getting Results with HiQ
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How can I prevent the Command Window from creating variables in 
my current workspace?

If you use the detach  command, all HiQ objects created in the Comman
Window from that point forward are not associated with the active 
notebook.

How do I save variables created in the Command Window?

If the HiQ objects were created while the Command Window was attac
to an active notebook, save the notebook, and all objects are saved w

How do I change the precision at which variables are displayed?

Right click on the Command Window and select Properties. In the 
property page, click on the Numbers tab. In the entry for Decimal Places, 
verify that the Auto option is not checked and set the precision required
you prefer trailing zeros, uncheck the Remove Trailing Zeros option.

Where can I find a list of available commands for the Command 
Window?

Refer to Chapter 2, HiQ Command Window, in the HiQ Reference Manual 
for a complete list and description of HiQ Command Window comman
for both HiQ and MATLAB modes.

Where can I find a list of available built-in functions for use in the 
Command Window?

Type help  to evoke the HiQ online help. Select Built-In Functions on the 
Contents tab to display a list of all available HiQ functions listed by nam
or category.

How do I view a variable in its own window?

Use the view  command followed by the name of the HiQ object.

Where can I find a list of variables accessible in my workspace?

Look at the Object List in the HiQ Explorer, or type the objects  command 
to get a list of available HiQ objects.

How can I tell if I am using the correct name of a built-in function?

By default, syntax highlighting is on. Syntax highlighting displays built-
function names in bright blue letters. If the cursor is in the text of the 
Getting Results with HiQ 10-8 © National Instruments Corporation
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function name, you can press <F1> to open the online help topic for th
function.

How can I keep a log of results generated by the Command Window?

To save the entire contents of the Command Window, right click on the
window, select Save As, and choose the name of the file in which you wa
the contents to be stored. To log specific messages to the Log Window
the logMessage()  function. To view this log, click on the Log tab in the
lower left corner of the Command Window.

How do I reuse previous command line statements?

Use the up and down arrow keys to access the history of commands. I
type the initial part of the command, the arrow keys cycle through only 
commands in the history that start with what you typed.

Comparing HiQ and MATLAB Commands
Many commands in MATLAB mode are defined in HiQ mode as well. 
Other commands are handled more efficiently or flexibly by other HiQ u
interfaces. Table 10-1 contains an alphabetical collection of general 
commands in MATLAB mode and the best way to achieve the same res
in HiQ.

Table 10-1.  HiQ and MATLAB Command Comparisons

MATLAB 
Command HiQ Equivalent

cd Type cd  in the Command Window.

clear 
objectName

Type delete  objectName  in the Command Window, where objectName  is 
the name of the object you want to delete.

diary Right click on the Command Window and select Save As to save the contents 
of the current Command Window. Type clear  to clear the Command 
Window contents before beginning the session you want to record.

dir Type dir  or ls  in the Command Window.

echo Use the built-in function logMessage  to record the supplied text in the Log 
Window.
© National Instruments Corporation 10-9 Getting Results with HiQ
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edit Edit the contents of a HiQ-Script through a view of the script object. Think o
this view as a built-in editor provided by HiQ specifically designed for editing
HiQ-Script. Use one of the following methods to create a view of a 
HiQ-Script.

• Type view  scriptName  on the command line, where scriptName  is the 
name of an existing HiQ-Script you want to edit.

• In the HiQ Explorer, find the name of the script in the tree structure un
the Objects branch. You can double click on it or press <Shift-Enter> 
create a view of the script in its own window.

• Type place  scriptName  on the command line, where scriptName  is the 
name of the script you want to edit. A view of the script is placed on th
current notebook page.

format Use the HiQ property pages. Right click on the Command Window, select
Properties, and click on the Numbers tab to access the formatting properti
for displaying numbers in the Command Window.

helpwin Press the <F1> key anywhere in HiQ to bring up the HiQ online help. From
there, you have access to all help resources. You also can type help  from the 
HiQ Command Window to activate the help system.

helpdesk Select Help»Visit HiQ Web Page to retrieve online product and technical 
information.

load In HiQ, all objects are stored within the Notebook. When you open the 
Notebook, all objects associated with that Notebook are automatically 
opened. You can open a Notebook with the File»Open command.

more Because views of HiQ objects are scrollable, creating a view of a particula
object allows you to inspect any portion of the object dynamically.

To specify where you want object views to appear, right click on the 
Command Window and select Properties. From the property pages, you can 
control which objects are displayed in the Command Window, which are 
viewed in their own windows, and the maximum size of a matrix or vector 
viewable in the Command Window. Matrices and vectors larger than the 
specified size are displayed in individual windows.

quit Type quit  in the Command Window or select Exit  from the File menu.

Table 10-1.  HiQ and MATLAB Command Comparisons (Continued)

MATLAB 
Command HiQ Equivalent
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If you do not find a command in Table 10-1, it might be because that 
command is unique to the MATLAB environment. For example, path 
commands such as rmpath  and addpath  do not have meaning in the HiQ
environment because a HiQ Notebook contains all of the objects and sc
associated with it.

save In HiQ, all objects are stored within the Notebook. Saving a Notebook sav
all of the objects associated with it. To save a Notebook, use Save or Save As 
from the File menu.

type List the contents of a HiQ-Script through a view of the Script object. Think o
this view as a built-in editor provided by HiQ specifically designed for 
inspecting and editing HiQ-Script. Use one of the following methods to crea
a view of a HiQ-Script.

• Type view  scriptName  on the command line, where scriptName  is the 
name of an existing HiQ-Script you want to view.

• In the HiQ Explorer, find the name of the script in the tree structure un
the Objects branch. You can double click on it or press <Shift-Enter> 
create a view of the script in its own window.

• Type place  scriptName  on the command line where scriptName  is the 
name of the script you want to view. A view of the script is placed on t
current Notebook page.

ver Select About HiQ  from the Help menu to get version and copyright 
information.

what From the File menu, select Open to display the current directory storing HiQ 
notebooks. By default, the file filter is set to the Notebook extension .HiQ  so 
that only HiQ Notebooks show in the directory listing.

whatsnew Select What’s New from the Help menu to read about new features in this 
version of HiQ.

who Type objects  in the Command Window or look at the Objects section in th
HiQ Explorer.

whos 
objectName

Type whatis  objectName  in the Command Window or look at the Objects 
section in the HiQ Explorer.

web Select Visit HiQ Web Page from the Help menu to visit the HiQ Web Page.

Table 10-1.  HiQ and MATLAB Command Comparisons (Continued)

MATLAB 
Command HiQ Equivalent
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Automated M-file to HiQ-Script Translator
The M-file to HiQ-Script translator is a tool you can use to convert you
M-file programs to HiQ. Its primary goal is to automate the change in 
language syntax, including loops (such as while and for), conditional 
execution (such as if and switch), and structure subranging. The trans
can map functions if the usage of the function is unambiguous. For 
example, some MATLAB functions map directly to built-in HiQ function
allowing the translator to replace the MATLAB function name with the
HiQ function name. Many MATLAB functions can be emulated by a 
user-defined function in HiQ. In these cases, the MATLAB functions a
prefixed with M__. When a script executes, the appropriate HiQ functio
from the translation library execute to produce equivalent results.

The translation maintains the readability of the script in both function ca
and common language syntax. Some language syntax used in M-files 
not match any syntax in HiQ-Script, in which case HiQ functions are us
in place of the language syntax to produce the proper results.

Using the Translator
The Import Wizard is the standard interface in HiQ for importing any kin
of data, including M-files. Use the following procedure to import M-files
with the HiQ Import Wizard.

1. Access the Import Wizard by selecting Import Wizard  from the 
Notebook menu or click on the Import Wizard icon in the toolbar.

2. In the Import From  section of the Import Wizard, select the File 
option and click on Browse to select the M-file you want to translate

After selecting the file, notice that the contents of the beginning of 
M-file appear in the Preview window.

3. If the Preview window is displaying the M-file you want to translate
click the Next button at the bottom of dialog box to continue.

If the file has the default MATLAB extension, .m, the Import Wizard 
automatically detects it as an M-file, and the Predefined option in the 
Format section selects the description M-file to HiQ-Script . In the 
upper right, notice the name of the script object that will hold the 
results of the translation. To see the results of the translation, look
the Preview window.

4. Click the Next button again to view the Translation Output Options
dialog, as shown in Figure 10-1.
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Figure 10-1.  Import Wizard—Translator Output Options

5. Select the translation options that you want. The following list expla
the options in more detail. Notice that the Preview window is 
automatically updated to reflect the new options.

• Header Comments—Inserts a header comment at the beginnin
of the translated file.

• Symbol Table—Includes a list of all symbols used in the 
translation. Use this option to verify the type descriptions of th
translated objects and functions.

• General Comments—Includes explanations and general 
comments about the details of the translation.

• Interleave M-file as Comments—Interleaves each line of the 
original M-file with the corresponding translated line in 
HiQ-Script. Use this option to compare M-file script code with th
automatically generated HiQ-Script code.

• Translation Footnotes—Appends additional translation 
footnotes to the end of the translation file. Use this option to obt
additional details about any limitations of the current translatio
© National Instruments Corporation 10-13 Getting Results with HiQ
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6. Click on Finish to complete the translation.

You also can translate M-files through the view of a script object. Althou
this approach has fewer options than the first, it provides a faster and m
automated way to translate an M-file. The results of both procedures ar
same.

1. To translate a new M-file, place a new view of a new script object 
the notebook page.

2. Right click on the view and select File»Import MATLAB M-file .

3. Select the M-file you want to import. After you select the file, the 
translation begins and the resulting translation is stored in the cur
script object. 

Working with the Results
If you translated your M-file using the Import Wizard, a view of that obje
is automatically placed on the Notebook page.

If you translated your M-file into an existing HiQ-Script view, the conten
of the HiQ-Script are replaced by the translated output.

Table 10-2 compares how common scripting errors are reported in 
MATLAB and HiQ.

Table 10-2.  Common Error Messages in MATLAB and HiQ

M-file Error Message HiQ-Script Error Message

Assignment using a variable that does not exist: y = x;

??? Undefined function or variable 
'x'.

The object "x" hasn't yet been 
assigned a value.

Calling a function that is not defined: y = x(5);

Warning: Reference to uninitialized 
variable 'x'.

"x" is not a function or polynomial.

Performing a language operation with incompatible object types:

??? Function '<op>' not defined for 
variables of class '<variableType>'.

Invalid operand types.
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To successfully execute a script, all functions in the script must be defined 
and compiled in the notebook. If you are translating an M-file that calls 
functions in other M-files, you need to translate those files to HiQ-Script 
and compile them to make them available to all scripts in the current 
Notebook.

HiQ-Script for MATLAB Users
Working in a new scripting language involves learning new syntax as w
as new functionality. Table 10-3, HiQ-Script for MATLAB Users, 
compares M-files and HiQ-Script to help you learn the HiQ syntax and 
functionality in the following categories:

• Script Comments

• Initializing Matrices

• Subscripting Matrices

• Expressions (for example, x = a + b/2; v = u.*w; E = B-C;)

• Operators (for example, .^, -, .\)

• Flow Control (for example, if , fo r , and while )

• Function Definitions

• Function Calls

Table 10-3.  HiQ-Script for MATLAB Users

MATLAB HiQ-Script

Script Comments

% A comment in an M-file // A comment in HiQ-Script

Initializing Matrices

M1 = [1];

M2 = [1 2 3 4 5];

M3 = [1; 2; 3; 4; 5];

M4 = [1 2 3; 4 5 6; 7 8 9];

M1 = {1};

M2 = {1, 2, 3, 4, 5};

M3 = {1; 2; 3; 4; 5};

M4 = {1, 2, 3; 4, 5, 6; 7, 8, 9};
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Subscripting Matrices

x = A(1,1);

v = A(1,:);

u = A(:,1);

y = A(5);

p = A(1:5,4);

q = A(2,3:7);

M = A(3:5,4:9);

x = A[1,1];

v = A[1];

u = A[:,1];

y = (toVector(A'))[5];

p = A[1:5,4];

q = A[2,3:7];

M = A[3:5,4:9]

Expressions

r = 1+sqrt(5)/2;

s = abs(5-7i);

z = (4+2i)*(3-8i);

x = exp(log(1e10*r));

y = log(exp(1e10*s));

r = 1+sqrt(5)/2;

s = abs(5-7*<i>);

z = (4,2)*(3,-8);

x = exp(ln(1e10*r));

y = ln(exp(1e10*s));

Operators

s = 5;

v = 1:.5:5;

M = [v; v; v; v];

r = s+s;

t = s.*r;

u = v.*v;

A = M./M;

B = M.\A;

C = A.^B;

D = C.';

E = D';

w = u - v;

n = v';

p = [n, n .^2, 2 .^n];

s = 5;

v = seq(1, 5, .5);

M = {v; v; v; v};

r = s+s;

t = s.*r;

u = v.*v;

A = M./M;

B = M.\A;

C = A.^B;

D = trans(C);

E = D';

w = u - v;

n = v';

p = {n, n .^2, 2 .^n};

Table 10-3.  HiQ-Script for MATLAB Users (Continued)

MATLAB HiQ-Script
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Flow Control

if errCode < 0
   disp(‘Invalid error code.’);
elseif errCode == 0
   disp(‘No errors occurred.’);
else
   warning(‘An error has 

occurred.’);
end

if errCode < 0 then
   message("Invalid error code.");
else if errCode == 0 then
   message("No errors occurred.");
else
   warning("An error has 

occurred.");
end if;

switch errCode
   case 0
      disp(‘No errors reported.’);
   case 1
      error(‘Error 1 occurred.’);
   case 2
      error(‘Error 2 occurred.’);
   otherwise
      error(‘Unhandled error code.’);
end

select errCode from 
   case 0:
      error("No errors reported.");
   case 1:
      error("Error 1 occurred.");
   case 2:
      error("Error 2 occurred.");
   default:
      error("Unhandled error code.");
end select;

i = 1;
absSum = 0;
while i <= size(A, 1)

j = 1;
while j <= size(A, 2)

absSum = absSum + abs(A(i, j));
j = j + 1;

end
i = i + 1;
if absSum == inf

break;
end

end

i = 1;
absSum = 0;
while i <= A.rows do

j = 1;
while j <= A.columns do

absSum = absSum + abs(A[i, j]);
j = j + 1;

end while;
i = i + 1;
if absSum == <inf> then

exit while;
end if;

end while;

Table 10-3.  HiQ-Script for MATLAB Users (Continued)

MATLAB HiQ-Script
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continue = 1;
absSum = 0;
for i = 1:size(A, 1)

for j = 1:size(A, 2)
absSum = absSum + abs(A(i, j));
if absSum == inf

continue = 0;
break;

end
end
if ~continue

break;
end

end

// multiple exits avoid 'continue'
absSum = 0;
for i = 1 to A.rows do

for j = 1 to A.columns do
absSum = absSum + abs(A(i, j));      
if absSum == <inf> then

// multiple-exit support
exit 2 fors;

end if;
end for;

end for;

Function Definitions

function m = slope(P1, P2)

% SLOPE Slope between two points.
% SLOPE(P1) computes the slope
% between two points stored in 
% the columns of P. 
% SLOPE(P1, P2) computes the
% slope between two points stored
% in column vectors P1 and P2.
if nargin == 1

m = P1(2,2)-P1(2,1);
m = m/(P1(1,2)-P1(1,1));

else
m = P2(2,1)-P1(2,1)
m = m/(P2(1,1)-P1(1,1));

end

function slope(P1, P2)

// Compute the slope of two points
// where the points are given in 
// columns of P1 or in two vectors,
// P1 and P2.

if __ins == 1 then 
m = P1[2,2]-P1[2,1];
m = m/(P1[1,2]-P1[1,1]);

else
m = P2[2]-P1[2];
m = m/(P2[1]-P1[1]);

end if;

   return m;
end function;

function [xmin, xmax] = minmax(x)

% MINMAX Compute the minimum and
% and maximum values in x.
xmin = min(min(x));
if nargout == 2
   xmax = max(max(x));
end

function minmax(x)

// Compute the minimum and
// maximum values in x.

xmin = min(x);
if __outs == 2 then 

xmax = max(x);
end if;
return xmin, xmax;

end function;

Table 10-3.  HiQ-Script for MATLAB Users (Continued)

MATLAB HiQ-Script
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Function Calls

matrix = abs(matrix); matrix = abs(matrix);

matrix = chol(matrix); matrix = choleskyD(matrix);

scalar = cond(matrix); scalar = cond(matrix);

scalar = cond(matrix, inf); scalar = cond(matrix, <Li>);

vector = eig(matrix); vector = eigen(matrix);

vector = eig(matrix, matrix); vector = eigen(matrix, matrix);

[V,D] = eig(matrix); [d,V] = eigen(matrix); D = diag(d);

[v,d] = eigs(matrix, 1); [d,v] = eigenDom(matrix);

[v,d] = eigs(matrix, 1, scalar); [d,v] = eigenSel(matrix, scalar);

matrix = eye(scalar); matrix = ident(integer);

scalar = fmin('cos', 3, 4); [,scalar] = optimize(cos, 
toVector(3.1));

scalar = fmins('fct', vector); [,scalar] = optimize(fct, vector);

scalar = fzero('sin', [a b]); scalar = root(sin, a, b);

scalar = fzero('sin', 3); scalar = root(sin, toVector(3));

matrix = inv(matrix); matrix = inv(matrix);

scalar = max(max(matrix)); scalar = max(matrix);

scalar = mean(mean(matrix)); scalar = mean(toVector(matrix));

scalar = norm(matrix); scalar = norm(matrix);

scalar = norm(matrix, 'fro'); scalar = norm(matrix, <frob>);

scalar = norm(matrix, 1); scalar = norm(matrix, <L1>);

scalar = plot(vector,vector); [graph, integer] = 
createGraph(vector, vector);

R = qr(matrix); R = QRD(matrix);

[Q,R] = qr(matrix); [R,Q] = QRD(matrix);

vector = rand(6, 1); vector = createVector(6, <random>);

Table 10-3.  HiQ-Script for MATLAB Users (Continued)

MATLAB HiQ-Script
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ab.
HiQ Online Help for MATLAB Users
HiQ offers online help specifically designed to help MATLAB users wo
in HiQ. You can access the online help in either of the following ways:

• Press <F1> and select any of the MATLAB topics from the Index t

• Type help  matlab  in the Command Window.

matrix = rand(5, 4); matrix = createMatrix(5, 4, 
<random>);

matrix = randn(3); matrix = createMatrix(3, 3, 
<random>, <normal>);

scalar = rank(matrix); integer = rank(matrix);

scalar = rank(matrix, 1e-4); integer = rank(matrix, 1e-4);

vector = roots([1 2 3 4]); vector = roots({poly: 
"x^3+2x^2+3x+4"});

[vector, ivector] = sort(vector); [vector, integerVector] = 
sort(vector);

matrix = sqrt(matrix); matrix = sqrt(matrix);

scalar = surf(matrix); graph = createGraph(matrix);

vector = svd(matrix); vector = sv(matrix);

[U,S,V] = svd(matrix); [U,S,V] = svd(matrix);

Table 10-3.  HiQ-Script for MATLAB Users (Continued)

MATLAB HiQ-Script
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
 Results with HiQ
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Québec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________ Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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HiQ Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
Hardware revision ___________________________________________________________

Interrupt level of hardware _____________________________________________________

DMA channels of hardware ____________________________________________________

Base I/O address of hardware ___________________________________________________

Programming choice _________________________________________________________

National Instruments software __________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards _______________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________

Other Products
Computer make and model ____________________________________________________

Microprocessor ______________________________________________________________

Clock frequency or speed ______________________________________________________

Type of video board installed ___________________________________________________

Operating system version ______________________________________________________

Operating system mode _______________________________________________________

Programming language _______________________________________________________

Programming language version _________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards _______________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________
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Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our pro
This information helps us provide quality products to meet your needs.

Title: Getting Results with HiQ™

Edition Date: January 1999

Part Number: 321886B-01

Please comment on the completeness, clarity, and organization of the manual.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

Thank you for your help.

Name _____________________________________________________________________

Title ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

E-Mail Address ______________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) ___________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039
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Prefix Meanings Value

p- pico 10–12

n- nano- 10–9

µ- micro- 10– 6

m- milli- 10–3

k- kilo- 103

M- mega- 106

G- giga- 109

t- tera- 1012

A

ActiveX 
(Microsoft ActiveX)

A programming system and user interface that lets you work with 
interactive objects. Formerly called OLE.

ActiveX control A standard software tool that adds additional functionality to any 
compatible ActiveX container.

ActiveX Control object An object in HiQ that represents an inserted ActiveX control.

ActiveX embedded 
object

An object placed into a container and unconnected to any other objec
application. See also embedded.

ActiveX Interface object An object in HiQ that represents an interface to an ActiveX automatio
server application. See the createInterface  function in Chapter 7, 
Function Reference, of the HiQ Reference Manual.

ActiveX linked object An object placed into a container and connected to another object or
application in the same container or in a separate container. See also linked.

ActiveX object An object in HiQ that represents an inserted ActiveX object.

argument See parameter.
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assignment A script statement that sets a value to a variable.

attribute See property.

B

built-in function One of many programming utilities in HiQ-Script that perform analysis
graphical, or utility operations.

C

caret See insertion point.

cell In a matrix or vector, the intersection of a row and column that contain
numerical value.

Color object A HiQ object that sets the color attributes of graphs and plots.

Command Window See HiQ Command Window.

comment An explanatory line or portion of a line in HiQ-Script.

compiled script A HiQ object containing HiQ-Script language that has been converte
code that a computer uses to execute the program.

ComponentWorks A collection of 32-bit ActiveX controls designed for building virtual 
instrumentation systems.

constant A predefined value in HiQ-Script.

cursor The pointer or other image that displays on screen to show the locatio
your mouse, trackball, or other pointing device.

D

data type See numeric type.

debug To check and correct invalid code in a HiQ script in order to eliminate er
during the compilation or execution of the script.

declaration A HiQ-Script statement that defines the scope of variables. Can be e
project or local.
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dialog box A window containing a message, interactive options, and buttons.

dock To attach a detachable window or toolbar to the HiQ window. 

drag-and-drop To move an object to a specific location, using the mouse to click on, 
and release the object. Depending on the location of release, a specif
action can occur.

E

embedded Inserted into a container object and unconnected to any other object
application. Compare this term to linked. See also ActiveX embedded 
object.

error message An information box that appears when HiQ cannot complete an actio
to an internal error, compile error, run-time error, or user error.

Explorer See HiQ Explorer.

expression A mathematical operator and its operands.

F

Font object A HiQ object type used to set the font attributes of graphs and plots.

function A block of code that performs a specific task in HiQ-Script; can be a H
built-in function or a user-defined function.

function call Specific HiQ-Script syntax that calls a user or built-in function with giv
parameters.

Function Object An object that represents the executable pseudocode of a complied 
object.

G

grab handle A site on a selected object that you click on and drag to move, size, 
reshape the object.

Graph object The HiQ object that contains a two-dimensional or three-dimensional
collection of plots. See plot.
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handle See grab handle.

HiQ Command Window An intuitive window where you type HiQ-Script to get immediate resu

HiQ Constant object A HiQ object that represents a constant in HiQ-Script.

HiQ Explorer An interactive window displaying the objects, sections, and pages of a
open Notebook.

HiQ Log Window A window to which you can post messages from HiQ-Script.

HiQ Object Browser A browser window in which you can view all the interfaces for ActiveX
servers, objects, and controls installed on your computer.

HiQ Tools toolbar Part of the HiQ user interface that contains icons for objects you can 
in a Notebook. Depending on your preference, the toolbar can appear
any edge of the interface, or as a floating palette.

HiQ-Script The intuitive HiQ programming language for mathematics.

I

IEEE Institute of Electrical and Electronic Engineers.

initialization In HiQ-Script, a designated syntax which creates a particular type of ob
for example, vector, matrix, color, and others.

insertion point The location where text will be inserted (also referred to as the caret).

K

keyword A reserved word in HiQ Script, such as if , then , or while , that is used for 
constructing specific types of programming statements.
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LabVIEW Laboratory Virtual Instrument Engineering Workbench. Program 
development application based on the programming language G used
commonly for test and measurement applications.

LabWindows\CVI An integrated ANSI C environment designed for engineers and scient
creating virtual instrumentation applications.

linked Inserted into a container object and connected with another object or 
application. Compare this term to embedded. See also ActiveX linked 
object.

local Describes the scope of an object. An object with local scope is not 
associated with the Notebook.

Log Window See HiQ Log Window.

loop A statement in HiQ-Script consisting of keywords and nested stateme
that performs a repetitive function. Also known as an iteration stateme

M

MATLAB Third-party software product for programming and working with data.

Matrix object A HiQ numeric object containing an array of elements with rows and 
columns. See vector.

message box A secondary window that appears containing information about the s
of a HiQ operation. See dialog box.

N

Notebook The workspace in HiQ that stores, organizes, and displays all the 
components of an analysis and visualization problem.

Numeric object A HiQ object type that is defined in terms of a numeric type (integer, r
or complex) and an object type (matrix, vector, polynomial, or scalar).

numeric type One of three types of a numeric object (integer, real, or complex).
© National Instruments Corporation G-5 Getting Results with HiQ
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object An entity in a HiQ Notebook that contains data of a specific type, for 
example, numeric, graphic, text, or HiQ-Script. Objects work together i
Notebook to generate and display solutions to analysis and visualizati
problems. Objects are always stored in a Notebook, but are not alway
visible on a Notebook page. See object view.

Object Browser See HiQ Object Browser.

Object List A window in HiQ that displays all the objects in a HiQ Notebook.

object view A HiQ object that is visible on a Notebook page.

OLE (Microsoft OLE) Object Linking and Embedding. A programming system and user inter
that lets you work with interactive objects. See ActiveX.

operand An object (or objects) modified by an operator.

operator Code in HiQ-Script that is specific to basic mathematical operations a
structure of HiQ-Script language. Often represented as a symbol, for 
example, "/ " represents division.

P

parameter An independent variable passed to a user-defined or built-in function c
a parameter list.

Plot object A HiQ object type that graphically represents a 2D or 3D function or d
set used in conjunction with a graph object. See graph.

Polynomial object A HiQ numeric object represented by an equation in the polynomial f
axn + bxn-1+cxn-2 + ...

pop-up menu A context-sensitive menu that you can access by right clicking with y
mouse on an object or on the Notebook.

Problem Solver A HiQ Notebook containing objects, including HiQ-Script, that allows y
to interactively perform analysis of data and display results for a broad c
of problems. For example, the expression evaluator problem solver ca
display the results of any expression.
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project Describes the scope of an object. An object with project scope is saved
the Notebook.

Properties dialog box A window in HiQ with tabbed pages (property pages) where you can
quickly set a wide variety of attributes for a given object.

property Attributes of a HiQ object. Examples include the color of a plot, the siz
a matrix, and the type of any object.

property page A tabbed subsection of a property dialog box containing a collection 
object attributes.

S

Scalar object A HiQ numeric object represented as a number. See vector and matrix.

scope In HiQ-Script, a HiQ-object declaration that specifies whether the obje
available to the entire Notebook (project) or is temporarily available (loc

script A block of code that performs a certain task. See HiQ script and compiled 
script.

Script object A HiQ object type containing HiQ-Script and from which you compile a
execute your program.

section tabs An organizing tool in a HiQ Notebook that lets you label and quickly ac
different parts of your Notebook.

selection handle A graphical control point of an object that provides direct manipulatio
support for operations of that object, such as moving, sizing, or scaling

selection tool The mouse cursor in HiQ shaped like a standard pointer arrow that let
select, move, and manipulate objects on the Notebook.

shortcut key A key or combination of keys that you press to invoke a command.

Standard toolbar Site on the user interface of HiQ that contains basic utility tools, for 
example, Save, Open, Cut, Paste, and, Print . Depending on your 
preference, the toolbar can appear on any edge of the interface, or as
floating window.

statement In HiQ-Script, a line of code consisting of various keywords, functions
and/or operators that performs a certain task.
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status bar A region, usually the bottom of a window, containing information abo
HiQ and any selected object.

symbol The name for objects in HiQ for the Macintosh.

T

Text object A HiQ object type where you can enter and edit text.

toolbar Site on an application interface that contains various buttons and othe
controls. Depending on your preference, a toolbar can appear on any 
of the interface, or a floating window.

tooltip A small, descriptive pop-up window that appears when you position th
mouse cursor over a toolbar icon.

type A classification of an object based on its characteristics, behavior, and
attributes.

U

Untyped object A HiQ object that has not been assigned a value.

user-defined function A function that a user creates in HiQ-Script to perform customized 
analysis, graphical, or utility operations.

V

Vector object A HiQ numeric object containing an array with one row or column. 
Compare with matrix.
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Symbols
> prompt, 3-2, 10-2
» prompt, 10-3

Numerics
2D graphs, 5-1 to 5-10

automatically generating HiQ-Script with 
new plots, 5-3

Climate Notebook example, 5-1 to 5-10
creating, 5-1 to 5-2
modifying graph and plot, 5-4 to 5-6
plotting data, 5-2 to 5-4
working with multiple plots, 5-6 to 5-10

3D graphs, 5-10 to 5-14
creating, 5-11
modifying graph and plot, 5-12 to 5-13
panning, 5-14
rotating, 5-14
Seismic Notebook example, 5-10 to 5-13
zooming, 5-14

A
ActiveX automation client, 1-8, 7-1
ActiveX automation server, 1-8, 7-2
ActiveX controls

accessing programmatically, 7-4 to 7-5, 
7-10 to 7-12

adding ComponentWorks ActiveX controls, 
7-3 to 7-6, 7-8 to 7-12

distributing with Notebooks, 9-2
ActiveX controls container, 1-7, 7-2
ActiveX design mode, 7-3
ActiveX document container, 7-1
ActiveX document server, 7-1
ActiveX environment, 1-7 to 1-8

ActiveX Object Browser, 7-4
ActiveX objects

adding Microsoft Word Document objects,
7-6 to 7-8

analyzing data with HiQ-Script, 6-1 to 6-10
automatic generation of HiQ-Script, 4-3, 5-3
automatically executing functions, 9-3
automating HiQ-Script analysis, 6-8 to 6-9

B
backslash operator, 3-5
binary files

importing as numeric object, 4-9

C
Climate Notebook

adding ActiveX, 7-2 to 7-8
ComponentWorks ActiveX controls, 

7-3 to 7-6
Microsoft Word Document object, 

7-6 to 7-8
analyzing data with HiQ-Script, 6-1 to 6-5
converting to Problem Solver, 8-1 to 8-4
importing data, 4-1 to 4-4
maintaining help file for, 9-4 to 9-5
previewing in HiQ Reader, 9-1 to 9-2
visualizing data in 2D, 5-1 to 5-10

creating graphs, 5-1 to 5-2
modifying graph and plot, 5-4 to 5-6
plotting data, 5-2 to 5-4
working with multiple plots, 

5-6 to 5-10
Command Window, 3-1 to 3-14

> prompt, 3-2
adjusting the window, 3-1
changing default name for objects, 3-3
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Index
copying and pasting, 3-6
default position, 3-1, 10-2
floating Command Window, 3-1 to 3-2
for MATLAB users, 10-2 to 10-11

» prompt, 10-3
accessing, 10-2
comparison of HiQ and MATLAB 

commands, 10-9 to 10-11
frequently asked questions, 

10-7 to 10-9
MATLAB compatibility mode, 

10-3 to 10-6
sharing MATLAB data and 

functionality with HiQ, 
10-4 to 10-6

getting help, 3-10
hiding results using semicolon, 3-2
modifying Notebooks from, 3-12 to 3-14
multiline commands, 3-4
navigating, 3-1 to 3-4
recalling and editing commands, 3-4, 3-7
saving objects, 3-8
syntax highlighting, 3-3
using with Notebooks, 3-10 to 3-12

ComponentWorks ActiveX controls
adding to Climate Notebook, 7-3 to 7-6
adding to Seismic Notebook, 7-8 to 7-12
distributing with HiQ Notebooks, 9-2
property pages, 7-3

creating Notebooks
Climate Notebook example, 4-1
Seismic Notebook example, 4-5

D
data fitting and interpolation functions, 1-4
data fitting Notebooks, 2-1 to 2-4
data importing. See importing data.
data visualization. See visualizing data
detach command, 10-8
differential equation functions, 1-6

differentiation functions, 1-7
distributing Notebooks, 9-1 to 9-5
documentation

about this manual, xi to xiv
conventions, xiii to xiv
getting results with this manual, xi to xii
organization of this manual, xii to xiii
related documentation, xiv

E
examples

addPlot function, 3-8, 6-4, 7-5
arithmetic mean, 3-12, 6-1, 8-3
associating plots with second y-axis, 

8-2 to 8-3
automatically executing functions, 9-3
backslash operator, 3-5
comments, 10-15
converting existing script to Problem 

Solver script, 8-5
createGraph function, 3-3, 3-8, 3-12
creating a matrix, 3-2, 3-5, 3-8
creating a polynomial, 3-2
creating a vector, 3-5, 3-11, 6-6
Expression Evaluator Problem Solver, 

2-4 to 2-7
expressions, 10-16
fct function, 3-7
fit function, 6-4, 7-5
flow control, 10-17 to 10-18
function calls, 10-19 to 10-20
function definitions, 10-18
importing and graphing data, 8-2
initializing an ActiveX control, 9-3
initializing matrices, 10-15
integrate function, 6-6, 7-11
MATLAB, 10-15 to 10-20
modifying plot styles, 8-2
ODEIVP function, 3-8
onOpen function, 9-3
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operators, 10-16
placing objects on the Notebook, 3-12
Population Fit Notebook, 2-1 to 2-4
programmatically accessing 

ComponentWorks ActiveX controls, 
7-5, 7-10 to 7-11

removePlot function, 7-5, 8-2
solve function, 3-5
solving a linear system of equations, 

3-4 to 3-5
solving a system of ordinary differential 

equations, 3-5 to 3-9
subrange operator, 6-1
subscripting matrices, 10-16
user functions, 7-10 to 7-11, 10-18
viewing objects, 3-12

Examples folder, 1-2, 1-8, 2-2
Export Wizard, 4-9
Expression Evaluator Problem Solver 

Notebook, 2-4 to 2-7
entering data, 2-6 to 2-7
opening, 2-5
running scripts, 2-6 to 2-7

F
functions

automatically executing, 9-3
data fitting and interpolation, 1-4
differential functions, 1-6
differentiation, 1-7
integration, 1-6
linear algebra, 1-4
mathematical, 1-4 to 1-7
nonlinear analysis, 1-6
optimization, 1-6
polynomial, 1-7
statistics, 1-6

G
graphs, 5-1 to 5-14

automatically generating HiQ-Script with
new plots, 5-3

Climate Notebook example, 5-1 to 5-10
creating, 5-1 to 5-2, 5-11
modifying graph and plot, 5-4 to 5-6, 

5-12 to 5-13
panning, 5-14
plotting data, 5-2 to 5-4, 5-11
rotating, 5-14
Seismic Notebook example, 5-10 to 5-13
visualizing data, 5-1 to 5-4, 5-11
working with multiple plots, 5-6 to 5-10
zooming, 5-14

H
help. See online help.
HiQ

environment, 1-2 to 1-8
installing, 1-1 to 1-2
launching, 1-2
system requirements, 1-1

HiQ ActiveX Object Browser. 
See ActiveX Object Browser.

HiQ Command Window. 
See Command Window.

HiQ Notebook. See Notebooks.
HiQ Reader, 9-1 to 9-2
HiQ-Script

 See also examples.
analyzing data with HiQ-Script, 

6-1 to 6-10
automated M-file to HiQ-Script 

translator, 10-12 to 10-15
translation options, 10-13
using the translator, 10-12 to 10-14
working with translated results, 

10-14 to 10-15
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built-in functions, 6-4
case sensitivity, 6-4
compiling all scripts in a Notebook, 8-2
definition, 1-3
generating with Import Wizard, 4-3
generating with new 2D plots, 5-3
syntax comparison for MATLAB users, 

10-15 to 10-20
View Source, 2-3

I
Import Wizard

about, 4-1
advanced options, 4-7
Climate Notebook example, 4-1 to 4-3
generating HiQ-Script, 4-3
importing M-files, 10-12 to 10-14
Seismic Notebook example, 4-5 to 4-6

importing data, 4-1 to 4-9
binary files, 4-9
Climate Notebook example, 4-1 to 4-4
custom import mode option, 4-9
formatting options, 4-7
M-files, 10-12 to 10-14
Seismic Notebook example, 4-4 to 4-7
text files, 4-8

installing HiQ, 1-1 to 1-2
integration functions, 1-6

L
launching HiQ, 1-2
linear algebra functions, 1-4

M
manual. See documentation.
Manuals folder, 1-2

MATLAB compatibility, 10-1 to 10-20
» prompt, 10-3
accessing MATLAB compatibility mode, 

10-3 to 10-4
automated M-file to HiQ-Script 

translator, 10-12 to 10-15
translation options, 10-13
using the translator, 10-12 to 10-14
working with the translated results, 

10-14 to 10-15
frequently asked questions, 10-7 to 10-9
get and getall commands, 10-4
getting help, 10-7, 10-20
hiq command, 10-6
HiQ-Script syntax, 10-15 to 10-20
leveraging MATLAB work in HiQ, 

10-1 to 10-2
matlab command, 10-3
put and putall commands, 10-4
sharing MATLAB data and functionality 

with HiQ, 10-4 to 10-6
using the Command Window, 

10-2 to 10-11
accessing, 10-2
comparison of HiQ and MATLAB 

commands, 10-9 to 10-11
working in MATLAB compatibility 

mode, 10-3 to 10-6
Microsoft Word document

embedding as ActiveX object, 7-6 to 7-8
multiline commands in the Command 

Window, 3-4
Multiple Document Interface (MDI), 1-8

N
National Instruments technical support, 

A-1 to A-2
navigating the Command Window, 3-1 to 3-4
nonlinear analysis functions, 1-6
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Notebooks, 2-1 to 2-7
See also Problem Solvers.
as ActiveX objects, 1-7
creating help files for, 9-3 to 9-5
definition, 1-2 to 1-3
distributing to others, 9-1 to 9-5
examples, 2-1 to 2-7
help for current Notebook, 9-3 to 9-5
interacting with, 1-8 to 1-9
modifying from Command Window, 

3-12 to 3-14
opening, 4-1, 4-5
as organizational tools, 1-2 to 1-3
sharing with others, 9-1 to 9-5
working with multiple windows, 1-8

O
Object List, 2-4
objects, 2-7 to 2-8

changing default name in Command 
Window, 3-3

definition, 1-2 to 1-3
deleting, 2-8
deleting views, 2-8
importing binary file as numeric

object, 4-9
importing text file as numeric object, 4-8
importing text file as text object, 4-8
placing on Notebook page

from Command Window, 3-12
from the Object List, 6-2

saving objects created in Command 
Window, 3-8

setting default view properties, 6-3
views, 2-8

online help
accessing, 1-9
Command Window help, 3-10
distributing with Notebooks, 9-3 to 9-5
MATLAB compatibility, 10-7, 10-20

opening Notebooks, 2-2
optimization functions, 1-6

P
panning 3D graphs, 5-14
plots. See graphs.
polynomial functions, 1-7
Population Fit Notebook, 2-1 to 2-4

opening a Notebook, 2-2
running a script, 2-3
viewing the Object List, 2-4

previewing Notebooks, 9-1 to 9-2
Problem Solvers

Climate Notebook example, 8-1 to 8-4
definition, 2-4, 8-1
entering data, 2-6 to 2-7
Expression Evaluator Problem Solver, 

2-4 to 2-7
Seismic Notebook example, 8-5 to 8-6

Program folder, 1-2
properties

setting default view, 6-3

R
Reader. See HiQ Reader.
recalling and editing commands, 3-4
requirements. See system requirements.
rotating 3D graphs, 5-14
running scripts, 1-8 to 1-9, 2-3

S
script. See HiQ-Script.
Seismic Notebook

adding ComponentWorks ActiveX 
controls, 7-8 to 7-12

analyzing data with HiQ-Script, 
6-6 to 6-10

automating analysis, 6-8 to 6-10
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converting to Problem Solver, 8-5 to 8-6
importing data, 4-4 to 4-7
viewing help for, 9-5
visualizing data in 3D, 5-10 to 5-13

creating graphs, 5-11
modifying graph and plot, 

5-12 to 5-13
panning, 5-14
rotating, 5-14
zooming, 5-14

semicolon
hiding results in Command Window, 3-2

sharing Notebooks with others, 9-1 to 9-5
starting HiQ, 1-2
statistics functions, 1-6
system requirements, 1-1

T
technical support, A-1 to A-2
terse mode, 10-7
text files

importing, 4-8
three-dimensional graphs. See 3D graphs.
two-dimensional graphs. See 2D graphs.

V
verbose mode, 10-7
View Source, 2-3
viewing the Object List, 2-4
visualizing data, 5-1 to 5-14

Z
zooming 3D graphs, 5-14
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